
Operating Instructions

METTLER TOLEDO
DE40, DE50 and DE51 Density Meters

V2.00





METTLER TOLEDO  DE40/50/51 Density Meter 3

Contents Page

1. Introduction ................................................................................................... 6

2. Safety measures ............................................................................................ 7

3. The density .................................................................................................... 8

3.1 Definition .......................................................................................................... 8

3.2 Measurement principle ..................................................................................... 8

3.3 Construction of the measuring cell and temperature control .......................... 11

4. The instrument ............................................................................................ 12
4.2. Keyboard ........................................................................................................ 14

4.3 Display ........................................................................................................... 17

5. Getting started ............................................................................................. 18
5.1 Setting up the instrument ............................................................................... 18

5.2 Performing the first adjustment (calibration) .................................................. 19

5.3 Perform a measurement ................................................................................ 23

6. Sample (Number and ID) and Sample File ................................................ 26
6.1 Sample File (sample changer) ....................................................................... 26

7. Report (password protected) ..................................................................... 29

8. Measuring parameter (password protected) ............................................ 30
8.1 Method name ................................................................................................. 30

8.2 Measuring temperature .................................................................................. 31

8.3 Measurement stability .................................................................................... 31

8.4 Limit time ........................................................................................................ 32

8.5 Sequence (sampling, drain, rinse, purge) ...................................................... 32

8.6 Adjustment mode (Calibration selection) ....................................................... 34

8.7 Explanation of auto-sampling and auto-draining ............................................ 35

9. Calculation parameters (password protected) ......................................... 36
9.1 Density: d, d(t/4), d(t/t) ................................................................................... 36

9.2 Result (Density, Concentration, BRIX, ALCOHOL, USER TABLE) ................ 36

9.3 Temperature compensation............................................................................ 41

9.4 Decimals ........................................................................................................ 42



4 METTLER TOLEDO  DE40/50/51 Density Meter

Contents

Page

10. Functions (password protected) ............................................................... 43

10.1 Data File (Function 0) ..................................................................................... 43

10.2 Sample File (Function 1) ................................................................................ 46

10.3 Method File (Function 2) ................................................................................ 46

10.4 Changer (Function 3) ..................................................................................... 46

10.5 Factor (Function 4) ......................................................................................... 47

10.6 Set check (Function 5) ................................................................................... 47

10.7 Periodic (Function 6) ...................................................................................... 51

10.8 Auto Start (Function 7) ................................................................................... 51

10.9 CARD Utility (Function 8) ............................................................................... 52

10.10 Memory Clear (Function 9) ............................................................................ 53

11. Setup (password protected) ....................................................................... 54
11.1 Interface (Setup 0) ......................................................................................... 54

11.2 Date and Time (Setup 1) ................................................................................ 55

11.3 Name (Setup 2) .............................................................................................. 56

11.4 Serial/Version number (Setup 3) .................................................................... 56

11.5 LCD Contrast (Setup 4).................................................................................. 57

11.6 International (Setup 5) .................................................................................... 57

11.7 Lock with password (Setup 6) ........................................................................ 58

11.8 Beep (Setup 7) ............................................................................................... 58

11.9 Temperature calibration (Setup 8) .................................................................. 59

12. Memory Cards (DE40, DE50 and DE51) .................................................... 60

12.1 Data Memory Cards: data, methods, sample files ......................................... 60

12.2 Save measured data ...................................................................................... 61

12.3 Clear measured data...................................................................................... 62

12.4 Load measured data ...................................................................................... 63

12.5 Save method .................................................................................................. 64

12.6 Clear internal method ..................................................................................... 65

12.7 Load method .................................................................................................. 66

12.8 Save sample file ............................................................................................. 68

12.9 Clear internal sample file ................................................................................ 68

12.10 Load sample file ............................................................................................. 69



METTLER TOLEDO  DE40/50/51 Density Meter 5

Contents

13. Application Memory Cards: BRIX, ALCOHOL, API, VISCOSITY CORREC-
TION, USER TABLES .................................................................................. 70

13.1 How to download an application (Install table) ............................................... 70

13.2 How to select the application ......................................................................... 71

13.3 How to retrieve an application (Uninstall table) .............................................. 73

14. Description of the special applications:
BRIX, ALCOHOL, API, VISCOSITY CORRECTION, COKE, USER T ABLES 75

14.1 API software ................................................................................................... 75

14.2 Alcohol software ............................................................................................. 75

14.3 BRIX software ................................................................................................ 76

14.4 Viscosity correction ........................................................................................ 76

14.5 Coke (Cola drinks) ......................................................................................... 77

14.6 Coefficients for conversion to various concentration data .............................. 77

15.  Automatic sampling pump ASU-DE (optional) ........................................ 78

15.1  Safety measures ........................................................................................... 78

15.2  Installation ..................................................................................................... 79

16. Error Messages and Malfunctions ............................................................. 82
16.1 Error Messages .............................................................................................. 82

16.2 Malfunction ..................................................................................................... 83

17. Maintenance ................................................................................................ 84

17.1 Changing internal battery ............................................................................... 84

17.2 Power line voltage, power line, fuse............................................................... 84

17.3 Replacing the silicagel ................................................................................... 84

17.4 Replacing the tube nozzles ............................................................................ 84

18. Standard and optional equipment ............................................................. 85
18.1 Standard equipment ....................................................................................... 85

18.2 Optional equipment ........................................................................................ 86

MemoCard DE40/50/51 (Short Instructions) .............................................................. 88

Annex 1: Density table of dried air ............................................................................ 89

Annex 2: Density table of pure water ........................................................................ 90

Specifications ............................................................................................................... 91



6 METTLER TOLEDO  DE40/50/51 Density Meter

1. Introduction

The DE40 and DE50/DE51 Density Meters measure the density d of gases, liquids and
solutions using the oscillating body method. They are distinguished by their temperature
range and their measurement accuracy. All three instruments:

• come with five certified water standards.

• measure gases, liquids and solutions with densities (d) in the range 0 to 3 g/cm3
.

(DE40: with 0.0001 g/cm3; DE50/DE51: with 0.00001 g/cm3).
• need a minimum amount of substance (1.2 millilitres) for measurement.
• keep the temperature of the sample being measured constant thanks to a built-in thermostat

control (DE40: between 4 and 90 °C, DE50/DE51: between 4 and 70 °C).
• have 10 methods stored in their memory, which you can change to suit your measurements.
• show the density relative to water (specific gravity) at 4 °C (d 

t

4 ) or at the measurement
temperature (d 

t

t ).
• calculate the concentration of a solution using tables or entered data of measured standard

solutions.
• calculate the density of a solution for a desired temperature using an entered temperature

function.
• have a built-in check function that allows to periodically check the accuracy of the instrument

without changing the instrument settings.
• store a maximum of 100 measured values.
• perform statistical evaluations (mean value, standard deviation, relative standard deviation)

and allow the recalculation of results.
• use Memory Cards for data storage, sample files and method transfer.

Special Application Memory Cards are available for all three instruments which allow the
automatic conversion of the experimental data into BRIX degrees, or alcohol concentration.
A special API software converts the density of oil products measured at elevated
temperatures automatically into the density at 15 °C (or 60 °F).

You can use an automatic sampling unit to perform continuous measurements; the built-in
RS-232C interface allows attachment of a computer to transfer experimental data. Print out
the entered parameters and data as well as results on a printer (option).

You can connect your instrument to a RE40 or RE50 refractometer to perform simultaneous
measurements of density and refractive index with one sample.

Connection of a SC24 sample changer allows fully automated measurements, even in
combination with a refractometer (RE40 or RE50).

Note : Examples of the density given in these Operating Instructions are for the DE50/DE51.

Introduction
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Safety measures

2. Safety measures

Measures for your safety

– Ensure that you plug the power cable supplied into a socket which is
grounded! In the absence of grounding, a technical fault could be lethal.

– Switch the instrument off and disconnect the power cable if you change
blown fuses! An electric shock could be lethal.

– Never work in a hazardous area! The housing of the instruments is not gas
tight (explosion hazard through spark formation, corrosion by gas diffusion
into the instruments).

– Measure readily inflammable, toxic and corrosive substances in a fume
hood and comply with the usual lab regulations!

Measures for operational safety

– Check the set operating voltage before you switch on the instrument! The
instrument will be damaged if the operating voltage does not match the line
voltage.

– Do not clean the measurement tube with concentrated sodium hydroxide
(caustic soda, NaOH) or hydrofluoric acid (HF)! Both substances chemi-
cally attack the measurement tube.

– Use only fuses of the specified type if you need to change them!

– Exclude the following environmental influences:
• powerful vibrations.
• direct sunlight.
• high atmospheric humidity.
• temperatures below 5 °C and above 35 °C.
• powerful electric or magnetic fields which influence the power supply

through large load fluctuations!
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Note: The DE40/DE50/DE51 calculate the relative density: the density of water at 4 °C 
(dt

t ) or at the measurement temperature (dt
t ) is available as a reference. For this

purpose, the density of pure water as a function of temperature is stored in the
instruments.

         Density

3. The density

3.1 Definition

The density ρ is the quotient of the mass m and the
volume V of a substance (mass density). As the
density depends primarily on the temperature, the
latter must always be specified.

The relative density is the ratio of the density ρ of a
substance to the reference density ρο of a reference
substance under conditions which must be
specified separately for both substances.

3.2 Measurement principle

The density measurement of the DE40 and the
DE50/DE51 is based on the electromagnetically
induced oscillation of a glass U-tube.

One complete back and forth movement of a vibration
is a period, its duration is the period of oscillation T.

The number of periods per second is the frequency f.
Each glass tube vibrates at a so-called characteristic
or natural frequency. This changes when the tube is
filled with substance. The frequency is a function of
the mass. When the mass increases, the frequency
decreases, in other words period of oscillation T
incrases.

A magnet is fixed to the measurement tube in the
DE40/DE50/DE51 which is made to oscillate by a
transmitter. A sensor measures the period of
oscillation T.

Amplitude

Time

Oscillation
period T

f =
T
1 [s-1]

ρ = 
V
m [kg/m3] or [g/cm3]

d = ρ0

ρ
[1]

Magnet

Oscillator/
Vibration meter

Measurement tube of defined
volumetric capacity
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Density

The period of oscillation T is obtained from the equation:

ρ = Density of sample in measurement tube [g/cm3]
Vc = Volume of sample (capacity of tube) [cm3]
mc = Mass of measurement tube [g]
K = Measurement tube constant [g/s2]

It follows that

The density and the period of oscillation T are related as follows:

ρ = A T2 + B   (see illustration)

A and B are constants which are determined by the elasticity, structure and mass of the
measurement tube. As the mass varies from tube to tube, it must be determined by
measurement. We refer to this as a factor determination or adjustment of the instrument. The
factor of the measurement tube is calculated by measuring the period of oscillation T of two
standard substances of known density, e.g. air and water:

ρA = Density of air [g/cm3]
ρW = Density of water [g/cm3]
TA = Period of oscillation of the air measurement [s]
TW = Period of oscillation of the water measurement [s]

The unknown density of a substance ρS
is calculated after the factor
determination by measurement of its
period of oscillation using the following
formula:

F (TA
2 – TS

2)  =  ( ρA – ρS)

Solving for ρS gives:

ρS  =  ρA – F (TA
2 – TS

2)

Note : The factor is temperature dependent. The volume of the measurement tube and its
period of oscillation change with temperature. It is thus necessary to determine the
factor of the cell for the temperature at which you measure your samples!

ρ
A
 = 0.00120

T 
2

ρ
ρ

W
 = 0.99821ρ

S

T
S

2

T
W

2

T
A

2

T = 2π ρVc + mc

K

ρ = 
4π2 Vc

K
T2 –

Vc

mc

F = 
4π2 Vc

K
TA

2  – TW
2

ρA
  – ρW=
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Density

The here described period of oscillation T is used to calculate the tube factor and from that
the density of the unknown sample. But this period of oscillation is not displayed on the
instrument. The DE40/DE50/DE51 display only the so-called T-value which is directly
related to the period of oscillation T:

Period of oscillation T  = T-value • Z • 0.2 µsec • (1/600)

with: Z =   10 for DE50/DE51
Z = 100 for DE40
T-value shown as T on the display of the instrument

So the T-value is an auxiliary value that makes use of the maximum display possibilities of
the instrument, using only digits and no decimals. This gives the maximum resolution
especially for the determination of the stability.

The stability for accepting the measured T-value can be set at three different levels (see
Section 8.3) to reduce measurement time, according to the need of the customer:

Stability 0: The stability of the measured signal (T-value) is waited for: ∆Tval ≤ 4 within 77 s
for the DE50/DE51, and ∆Tval ≤ 1 within 49 s for the DE40. The density is
measured with an accuracy of ±1*10-5 (DE40: ±1*10-4).

Stability 1: The final T-value is extrapolated with a patented algorithm from the course of the
slope (∆Tval/∆temp.), and the density is calculated. This cuts the measurement
time about by half while the result (i.e. density) in most cases is identical to that of
stability 0.

Stability 2: The final T-value is extrapolated at an earlier point with a patented algorithm
from the course of the slope (∆Tval/∆temp.), allowing a slightly higher
uncertainty, and the density is calculated. Thus the measurement time is cut
about by half again, while the density for most of the samples lies within ± 1 or 2
digits of that of stability 0.

End value

Time

End of measurement
with: stability 2 stability 1 stability 0
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3.3 Construction of the measuring cell and temperature control

For correct density measurements a very accurate temperature control and measurement
must be guaranteed.
As the temperature in the sample can not be measured directly without disturbing the
measurement of the oscillation, a different approach is used. The temperature is measured
in three different spots:

- temperature 1: sensor placed in the measuring cell, directly over the surface of the
measurement tube. This temperature is shown on the status display (cell
temperature).

- temperature 2: temperature of the thermoblock, not displayed (block temperature).

- temperature 3: reference temperature inside the instrument, not displayed (ambient
temperature).

From these three temperatures the actual temperature in the sample is calculated with a
patented algorithm.

Peltier element

Oscillator /
Vibration meter

Thermal insulation

Sample outlet
Sample inlet

Magnet Temperature sensor 1
(cell temperature)

Measurement tube

Temperature sensor 2
(block temperature)

Temperature sensor 3 (ambient temperature)

ThermoblockTemperature controller

The cell temperature is compared with the inputted set temperature. The temperature
controller uses this cellblock/set difference to control the thermoelectric module (Peltier
element) which heats or cools the thermostatic block accordingly.

Density
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4. The instrument

Front view

The instrument

6. Memory card slot

3. Cell window

2. Measuring cell

1. Desiccator
For drying the measuring cell. Filled with silica gel.

2. Measuring cell
Thermostated measuring cell (Oscillating glas U-tube).

3. Cell window
To have a view into the measuring cell (check for air bubbles).

4. LC display
The DE40, DE50 and DE51 have a seven-line liquid crystal display that shows measurement results,
conditions or parameters.

5. Keypad (alphanumeric)
Start measurement, input of measurement conditions or calculation parameters are operated on keys.

6. Memory card slot
To load and download data method and sample files and to load applications.

7. Sampling speed control (ASU-DE)
To set the sampling speed (high for high viscous samples, low for low viscous samples).

8. Sampling/Drain switch
When Sampling position is selected, the speed is controlled by the Sampling speed control. When Drain
position is selected, the speed is set to maximum (not controlled).

9. Drain tube
Connects the measuring cell out to the pump in (ASU-DE) or to a waste ( without ASU-DE).

10. Waste bottle (ASU-DE)
Collects waste liquid (sample and rinsing solutions).

11. Sampling tube (ASU-DE)
Connect to the measuring cell in.

12. GA42 Printer (optional)
METTLER TOLEDO matrix printer.

16. Connector to dry air
17. Pump in connector
       (only withASU-DE)

4. LCD display

7. Sampling speed
control (only with
ASU-DE)

9. Drain tube

5. Keypad

8. Sampling/Drain switch
(only with ASU-DE)

10. Waste bottle
(only with ASU-DE)

11. Sampling tube

12. GA42 printer (optional)

1. Desiccator
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The instrument

Rear view

17. Pump in connector
(only with ASU-DE)

13. Measuring cell out

14. Measuring cell in

15. Drain hole

16. Dry air out

18. Sample
changer connector

19. Waste bottle tube
connection (only with
ASU-DE)

20. Pump  exhaust (only
with ASU-DE)

21. Printer
 connector

22. RS-232C
 connector

23. Power switch

24. AC power connector

25. I/O connector
26. Ext. cell or AD-510

13. Measuring cell out
Measuring cell ouput connector. Connect the drain tube here (9).

14. Measuring cell in
Measuring cell input connector. Connect the sampling tube here (ASU-DE) or a syringe (no ASU-DE).

15. Drain hole
To drain sample or rinsing solutions in case of leakage.

16. Dry air out
To dry the measuring cell connect the sampling tube (11) to this connector which is attached the desiccator (1).

17. Pump in connector (ASU-DE)
Connect the drain tube here (ASU-DE).

18. Connector for sample changer
connection of the SC24, SC24H, SC24L, CHG-260B sample changer, or the DCU-300B auto rinsing unit.

19. Waste bottle tube connection (ASU-DE)
Connect these tubes to the waste bottle lid (black tube to the higher connector: air suction; white tube to the
main lid: sample in).

20. Pump Exhaust
The exhaust air from the waste bottle goes out here.

21. Printer connector
This is for connection to an external printer(GA42 printer).

22. RS-232C connector
This is for connection to a personal computer or to our RE40 and RE50 refractometers.

23. Power switch
The power of DE40/50/51 is turned on or off by this switch.

24. AC power connector
Connect the power cable to the power supply. The instrument will automatically adjust its power supply unit
to the specific line voltage of your country as long as this is in the range between 100 and 240 V AC.

25. I/O connector
For connection of the SOP40 or SOP50.

26. Ext. cell
Connector for an external cell (option) or for the automatic drain unit AD-510 (option).
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8
DEF

9
GHI

4
JKL

5
MNO

6
PQR

1
STU

2
VWX

3
YZ

. 0
BLK

-

Func.

Setup

Display

Report

 Method

Print

Enter

Reset

Check

Clear

Sample

Esc.

BSCalib.

Measure

7
ABC

Rinse/
Purge Pump

Meas.
Para

Calc.
Para

4.2. Keyboard

Description of each key and its function:

Sample: Key to set up sample parameters, like sample number and ID/No.

Report: Key to change print format.
There are three  kinds of format for printing.
(1) Short: Short form for printing minimum necessity of result data.
(2) GLP: GLP form, which complies with GLP requirements.
(3) Variable: User defined printing format.

Measuring Key to change measuring parameter:

parameter - Method name (8 characters, alphanumerical),

- Measuring temperature (from 15 to 70 °C),

- Stability (0, 1 or 2),

- Limit Time,

- Sample sequence (sampling, drain, rinse, purge and cell test),

- Calibration mode (air & water, other standards)

Calculation Key to change calculation parameter:

parameter - Result (d, d(t/t), d(t/4), application software). Setup concentration
  function.

Report

Sample

Meas.
Para

Calc.
Para

The instrument
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Method: Key to select the method (0 to 9). The selection is done either by
pressing the "Up" and "Down" key or by pressing the corresponding
number key.

Display: Key to change display or select numerics, capital or smallleters.

Print: Key to print the displayed message or parameters.

Function: Key to select following functions:

(0) Data File (statistics, delete data, re-calculate),
(1) Sample File,
(2) Method File,
(3) Changer (DCU-300, SC24, CHG-241),
(4) Factor (adjustment factor),
(5) Set Check (name, ref.value, tolerance),
(6) Periodic Check, Periodic Calibration (interval, show list),
(7) Auto Start (multiple measurement),
(8) CARD utility (install applications),
(9) Memory Clear (meas.data, meas.para, check list, calib. list, etc...).

Setup: Key to select the setup parameters as follows:

(0) Interface: Set up the RS-232C and the printer
(1) Date & Time: Set up date and time
(2) Name: Register name (laboratory or operator)
(3) Serial/Ver. No.: Display serial and version No. of the unit
(4) LCD Contrast: Adjust brightness of LC display
(5) International: Select format for date and select unit (°C/°F) for

temperature
(6) Lock: Set up a password for protection
(7) Beep: Select beep (on / off, duration)
(8) Temp.Calib: Run temperature calibration

Check: Key to start the instrument check: daily (always active) or precision
(only when due).

Calibration: Key to start a calibration.

Backspace: Key to erase one preceding letter or numeral.

Rinse/Purge With SC24 sample changers only. Runs an automatic rinse and purge
cycle, according to the selected sample sequence (see Meas.Para).

Function

Check

Setup

Calib.

BS

Method

Display

Print

Rinse/
Purge

The instrument
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Pump For ASU-DE sampling pump. Starts and stops the pump.

Clear: Key to erase the whole entry (2 x to clear names)

Escape: Key to return to the main display

Reset: Key to abort a measurement or a calibration and to return
to main display.

Measure: Key to start a measurement

0 – 9 key Key to enter alphanumeric characters (the selection capi
tal/small letter or number is done with the <Display> key).
To select B, press twice, for C press three times.
On the key with the number 0 there is BLK (BLK = blank)
to insert blank spaces..

Dot and hyphen key

Enter Key to confirm key entry. This key is also called [Enter]
key  in this manual.

Up

Left, Right Keys to move the cursor. The Left and Right keys are also
used for selection within the menus.

Down

Enter

. –

Clear

Esc.

Reset

Measure

7
ABC

Pump

The instrument




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4.3 Display

The DE40, DE50 and DE51 density meters have a seven line LCD display with 40 characters
per line. When the power is turned on (power switch on the rear of the instrument), the
following message will appear on the display.

The software version appears for a
short time. This software version can
also be displayed under Setup 3

"Serial/Version".

After a few seconds the main display will appear:

The message "Wait for Reay" will
blink until the cell temperature
reaches the set temperature.

Once the cell temperature has reached the set temperature:

The "No calibration" message
appears if the instrument has not
been calibrated before or if a
Memory Clear has been performed
(see section 10.10 "Memory Clear").

Note: The Oscillation value is the T-value described in section 3.2 "Measurement principle".

You can toggle between all available
units by pressing the <DISPLAY>
key:
- Oscillation (T-value)
- Density [d(t/4, d(t/t)] (1)
- Concentration (2)
- ALCOHOL (3)
- BRIX (3)

(1) Selection of d, d(t/t: Specific Gravity), d(t/4) is done under Calc.Para – Density.

(2) Selection of Concentration is done under Calc.Para – Result.

(3) Selection of ALCOHOL, BRIX is done under Calc.Para – Result, but requires to install the
application from a special Application Memory Card (see section 13).

The instrument

    5 place Density Meter

                    Version X.XX    DE50

0.Method-0                      01-01
Temp.( °C)                 Oscillation

Set  20.00
Cell 21.42

          Wait for Ready

0.Method-0                      01-01
Temp.( °C)                 Oscillation

Set  20.00
Cell 20.00

          No Calibration

                               845393

                               845393

0.Method-0                      01-01
Temp.( °C)              Density(g/cm3)

Set  20.00
Cell 20.00

          No Calibration
                               0.00120
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5. Getting started

Before connecting the power cord after unpacking the instrument loosen or remove the three
security screws: remove the backplane in the upper part of the instrument and loosen the
three large screws (marked with red) just right of the pump box (refer to section 15.2 for more
help).
These screws are used as a transportation security only to hold in place the measuring cell
during shipment. For correct operation they must be loosened or removed.

When the instrument is switched on the first time, it is recommended to reset it electronically
to its default values as described in section 10.10 (function 9, memory clear: all parameter).

5.1 Setting up the instrument

5.1.1 Printer (Setup 0)

If you work without printer you can skip this section and go directly to section 5.1.2.
Perform the following steps if you have a GA42 printer to connect:
- Make sure that the DIP switch 2 is ON on the GA42 printer.

- Press the <SETUP> key.

Select "0.Interface". Confirm with
<ENTER>.

Select "1.Printer". Confirm with
<ENTER>.

Select "GA-" with the → key.
Confirm with <ENTER>.

- To choose the format of the printed results press the <REPORT> key and choose between
"None", "Short", "GLP" and "Variable" (see section 7 "Report").

- Then press the <RESET> key.

Getting started

             < Setup >

0. Interface        5.International
1.Date & Time      6.Lock
2.Name             7.Beep
3.Serial/Version   8.Temperature
4.LCD Contrast

           < Interface >

           0.RS-232C
           1. Printer

           < Printer >

 Printer    : IDP-  DP-  GA-  Other
 Exit       :[Execute]



METTLER TOLEDO  DE40/50/51 Density Meter 19

5.1.2 Date and time (Setup 1)

- Press the <SETUP> key.
Select "1.Date&Time". Confirm with
<ENTER>.

Actual date and time are displayed.
Press <ENTER> key.
Enter date and time (the date format
is selected in the menu Setup „5.
International”) and confirm with
<ENTER>.

5.1.3 Enter the lab name (Setup 2)

- Press the <SETUP> key.

Select „2. Name”. Confirm with
<ENTER>.
The capital A  means that the
alphanumerical keyboard is in entry
mode for capital letters. Press the
<DISPLAY> key to change the entry
mode:
A: capital letters (A, B, C, D, ..)
a: small letters (a, b, c, d, ...)
1: numbers (0, 1, 2, 3, 4, ...)

Enter the lab name or the instrument name using the alphanumeric keys, e.g. „Quality
Lab 1”, and confirm with <ENTER>. The instrument is now ready for calibration and the first
measurements.

5.2 Performing the first adjustment (calibration)

For correct measurements the instrument should always be adjusted at the measuring
temperature.

After turning on the instrument allow at least  20  minutes for the instrument to warm up
before performing the first adjustment.

Note :
According to the International Vocabulary of Basic and General Terms in Metrology from DIN
the operation of bringing a measuring instrument into a state of performance suitable for its
use is called adjustment.

Getting started

          < Date & Time >

        16/07/1998  17:24

 Day   :[16]    Hour   :[17]
 Month :[ 7]    Minutes:[22]
 Year  :[1998]  Exit   :[Execute]

             < Setup >

0.Interface        5.International
1.Date & Time      6.Lock
2. Name             7.Beep
3.Serial/Version   8.Temperature
4.LCD Contrast

             < Name >              A

     Name  : [Quality Lab 1  ]

     Exit  : [Execute]

             < Setup >

0.Interface        5.International
1. Date & Time      6.Lock
2.Name             7.Beep
3.Serial/Version   8.Temperature
4.LCD Contrast
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The earlier used term calibration should not be used anymore for this purpose as soon as
instrument settings are changed or adapted in order to ensure correct  measurement values.

We recommend to select one method which you will dedicate to the adjustment:

Select
Stability 0
and Limit Time 0 s.

5.2.1 Clean the measuring cell

a) If  you have a sampling pump ASU-DE:

- Insert the sampling tube into a beaker containing a high volatile solvent (e.g. acetone or
ethanol).

- Press the <PUMP> key . Flush the measuring cell during approximately 10 s. Adjust the
sampling speed with the Sampling Adj. control at the rear right side of the instrument so that
it takes approximately 5 s from starting the pump to fill the measuring cell (the solvent
appears in the drain tube at the top of the cell). During the pumping  it is recommended to
remove the sampling tube from the beaker and insert  it again to create some air bubbles.
This will result in a much more efficient cleaning.

- Remove the sampling tube from the beaker.

- Press the <PUMP> key again to stop the pump.

b) If  you don't have a sampling pump ASU-DE (only a built-in air pump):

- Flush the measuring cell using a syringe  filled with approx. 10 mL of high volatile solvent
(e.g. acetone or ethanol). Suck back the remaining solvant with the syringe.

5.2.2 Dry (purge) the measuring cell

If  you have a sampling pump ASU-DE or not, the following steps will be the same:

- Insert the sampling tube into the dry air outlet (white connector without black ring).

- Keep the <PUMP> key pressed for approx. 2 s  (until the message "Purge Checking"
appears on the display.

This Purge Checking will auto-
matically turn off the pump when the
cell will be dry, i.e. when the
oscillation value doesn't change
anymore.
Note : you can also stop the pump

yourself by pressing the
<PUMP> key .

Getting started

9.ADJUST                        01-01
Temp.( °C)                 Oscillation

Set  20.00
Cell 20.00

            Purge Checking
                               845393

Method 9    < Meas.Parameter >    VA

Method Name      :[ADJUST ]
Measurement Temp.:[ 20.00] °C
Stability        :[0]
Limit Time       :[   0]s
Sequence         : Off  On
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5.2.3 Performing the air adjustment

Whether you have a sampling pump ASU-DE or not, the following steps will be the same:

- Press the <CALIB.> and follow the directions on the display:

If the cell is really clean and dry,
press <ENTER>.

While adjusting to the air value the
display shows:

Wait until the next message is
displayed.

5.2.4 Performing the water adjustment

- Open a vial of certified water (one of the five delivered water standards). This water will be
used for the adjustment.

Note : you can also use bi-distilled water, but we recommend to use our certified water for
traceability.

a) If  you have a sampling pump ASU-DE:

- Remove the sampling tube from the measuring cell.

- Remove the drain tube connection from the ASU-DE pump (white connector with black ring).

b) The next steps will be the same wether you have a sampling pump ASU-DE or not:

- Pierce the septum of the certified water standard with the tip of the syringe.

- Fill the syringe with approx. 8 mL of certified water.

- Remove the tip of the syringe and insert the syringe in the sample inlet (lower measuring tube
connection).

- Perform an analytical rinse, i.e. fill approx. 2 mL carefully, wait for 10 s without removing the
syringe, then fill in again 2 mL very carefully. During the filling watch carefully that no air
bubbles enter the measuring cell.

Getting started

9.ADJUST                        01-01
Temp.( °C)                 Oscillation

Set  20.00
Cell 20.00

            Purge OK?
                               845393

9.ADJUST                        01-01
Temp.( °C)                 Oscillation

Set  20.00
Cell 20.00

            Set Water
                               845393

9.ADJUST                        01-01
Temp.( °C)                 Oscillation

Set  20.00
Cell 20.00

            Calibrating
                               845393
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- Leave the syringe in the sample inlet .

- Press <ENTER>.
While adjusting to the water value
the display shows:

At the end the calibration result is
displayed. The number on the right
side is the calibration factor (see
section 3.2 "Measuring principle")
and can be considered as a cell
constant.

The results of the adjustment are
printed on the attached printer:

When the instrument fails to do the
adjustment it will show the error
message:

In such a case clean the measuring cell well, dry it, and repeat the adjustment. If it fails again,
then exchange the pure water (make sure it really is of the appropriate quality. i.e. our
certified water standard, doubly distilled or correctly deionized). If the adjustment still does
not succeed, contact your dealer for technical assistance.

Getting started

[Calibration]
Date : 29/06/1998 11:15

Result      : OK
Temperature :  20.0 °C

        OLD –––> NEW
Air
 T    845392   845393
 d   0.00120  0.00120

Water
 T   1086413  1086415
 d   0.99820  0.99821

Factor
     2.141345  2.141349

Name : Quality Lab 1
       ----------------

9.ADUST
Temp.( °C)

Set  20.00
Cell 20.00

            Calibration
              FAILED

9.ADJUST                        01-01
Temp.( °C)                 Oscillation

Set  20.00
Cell 20.00

            Calibrating
                              1086415

9.ADJUST
Temp.( °C)

Set  20.00
Cell 20.00

            Calibration
                OK          2.141349
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5.3 Perform a measurement

Perform for example two measurements with your standard sample.

5.3.1 Set the parameter of the method

- Press the <MEAS.PARA> key.
Enter your method name and
measuring temperature. Leave
stability and limit time as given.
Select "Sequence On" with the →
key (with ASU-DE). The sequence
has to be "Off" without ASU-DE.

Setting of the sequence with
ASU-DE: Set the parameters accor-
ding to the following displays.

5.3.2 Define the sample file (with or without ASU-DE)

- Press <SAMPLE> to enter the sample data: sample number and sample ID.

Enter sample no, for example 02-01:
press 2 <ENTER> 1 <ENTER>.

Enter your sample ID using the
alphanumeric keys (max. 10
characters) and confirm with
<ENTER>.

Getting started

Method 0    < Meas.Parameter >    VA

Method Name      :[TestMeth]
Measurement Temp.:[ 20.00] °C
Stability        :[1]
Limit Time       :[  600]s
Sequence         : Off  On

Method 0    < Meas.Parameter >    VA

Sampling       : Off  Set  Auto
Sampling Time  :[   5]s
Drain          : Off  Set  Auto
Drain Time     :[  10]s
Rinse-1        : Off  Set

Method 0    < Meas.Parameter >

Calib.         :<Air&Water>
Exit           : [Execute]

Method 0    < Meas.Parameter >    VA

Rinse-1 Time   :[   5]s
Rinse-2        : Off  Set  Auto
Purge          : Off  Set  Auto
Purge Time     :[  60]s
Cell Test      : Off  On

             < Sample >

   Sample No.  : [02]-[01]
   Sample ID   : [ORANGE    ]
   Exit        : [Execute]
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Getting started

5.3.3 Sampling with ASU-DE

- Dip the sampling tube into the beaker containing your sample.

- Press the <MEASURE> key.
The sampling will be done auto-
matically, according to the
predefined time.

Once the sampling is done, remove
the sampling tube from the beaker.

5.3.4 Sampling without ASU-DE

- Fill the syringe with approx. 3 mL of your sample.

- Insert the syringe in the sample inlet (lower measuring tube connection).

- Fill  the measuring cell with the syringe (approx. 2 mL). During the filling watch carefully that
no air bubbles enter the measuring cell.

- Leave the syringe in the sample inlet.

5.3.5  Measurement

Press the <MEASURE> key.

Press the <DISPLAY> key to switch
from Oscillation to Density .

When the measurement is finished,
the result is displayed and printed.

Note : This printout corresponds to the selection
GLP for the  report. See section 7 "Report"
for more information.

*** Result ***

Sample No.    02-01

Date : 29/06/1998 11:15
Sample ID   : ORANGE
Method No.  : 0
Method Name : TestMeth
Meas.Temp.  : 20.00 °C
Period T    : 1086422
d[g/cm3]    : 0.99821

Meas.Time  : 00:00:36

Name : Quality Lab 1
       --------------

0.TestMeth           ORANGE      2-01
Temp.( °C)                 Oscillation

Set  20.00
Cell 20.86

            Measuring
0.TestMeth           ORANGE     02-01
Temp.( °C)              Density(g/cm3)

Set  20.00
Cell 20.00

                               1086414

              Result
                               0.99820

11.TestMeth           ORANGE    02-01
Temp.( °C)                 Oscillation

Set  20.00
Cell 20.86

            Sampling
                               1086414
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0.TestMeth           ORANGE     02-01
Temp.( °C)              Density(g/cm3)

Set  20.00
Cell 20.00

             Set Rinse-1
                               0.99820

Getting started

5.3.6 Cleaning and rinsing of the cell with ASU-DE

Follow the instructions on the
display for the rinsing and purging.
Use a highly volatile solvent (e.g.
acetone or ethanol) for the rinsing.

5.3.7  Cleaning the cell without ASU-DE

- suck back the sample into the syringe.

- flush the measuring cell with appropriate solvent.

- if necessary flush again with a highly volatile solvent (for example acetone or ethanol) to
facilitate the drying of the cell.

- dry the measuring cell according to section 5.2.2.
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6. Sample (Number and ID) and Sample File

Here you can define your sample identifications like sample number and sample ID.

The sample number is composed of two parts: for example [03]–[01].

[03]: The first two-digit number – ranging from 00 to 98 – represents the series number of
your measurement series. In the instrument it is called "High Sample No.". If you group your
measurements of different sample types by this series number, you can conveniently
process your data statistically later on.

[01]: The second two-digit number – ranging from 00 to 99 – is automatically increased by
one per measurement.

Additionally you can define a sample ID, for example a sample name or the Lot number.

Press the <SAMPLE> key.

Enter the sample ID using the alpha-
numeric keys (max. 10 characters
including "space", "period" and
"hyphen").
(*) Appears with DE51, or with DE40
with viscosity correction (memory
card).

6.1 Sample File (sample changer)

If you have connected a sample changer (see Function 3 "Changer") or set a sample file (see
Function 1 "Sample File") another display will appear when pressing the <SAMPLE> key:

The first line is usually skipped,
except when you want to SAVE OR
load a sample file with a Memory
Card (see section 12.8 to 12.10).

Max.Meas.No:
This is the total number of samples to be measured. This number can be higher than 24
(when used with the SC24). This number can be changed during the measurement. For
example set this number to 12 if you have only 12 samples to measure when you start and
change it later to 25 if you get 13 more samples to measure.

Next.Meas.No:
This is the next measurement number (according to the sample file). It is increased
automatically after each measurement.

             < Sample >

   Sample No.  : [03]-[01]
   Sample ID   : [ORANGE    ]
   Viscosity    : off  on         (*)
   Exit        : [Execute]

             < Sample >
Sample File      : Skip   Load   Save
Max.Meas.No.     :[  24]
Next.Meas.No     :[   1]
Method           :Current  Variable
Set Parameter    :[Execute]
Exit             :[Execute]

Sample and sample file
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Method:
Here you can select if you want to perform all measurements with one method only (current
method) or with different methods (variable).

Example:
You always get a series of 12 samples of grape juice and 7 samples of orange juice to
measure. You want to check for each series your instrument with a check standard.
You will have to set up 3 different methods as follows:

Method-0 Method-1 Method-2
Method Name Grape.J CheckStd Orange.J
Meas.Temp. 20.00°C 20.00°C 20.00°C
Stability 2 0 2

You will the define a sample file as follows:

This sample file will run all 12 Grape
juices with method 0 "Grape.J",

then the check standard with
method 1 "CheckStd" (this method
has a higher stability as it is required
to check the instrument),

then run all 7 orange juices.

It will allow to run the statistics on
each sample separately.

If the next series would be without
the first 12 grape juices , you would
have to select:
Max.Meas.No: 20
Next.Meas.No: 13

             < Sample >
Sample File      :Skip   Load   Save
Max.Meas.No.     :[  20 ]
Next.Meas.No     :[   1 ]
Method           :Current  Variable
Set Parameter    :[Execute]
Exit             :[Execute]

Sample and sample file

          < Sample List>
No. M S.No. Sample ID
1 0 01-01 GRAPE
2 0 01-02 GRAPE
3 0 01-03 GRAPE
4 0 01-04 GRAPE
5 0 01-05 GRAPE
6 0 01-06 GRAPE
7 0 01-07 GRAPE
8 0 01-08 GRAPE
9 0 01-09 GRAPE
10 0 01-10 GRAPE
11 0 01-11 GRAPE
12 0 01-12 GRAPE
13 1 50-01 STANDARD
14 2 02-01 ORANGE
15 2 02-02 ORANGE
16 2 02-03 ORANGE
17 2 02-04 ORANGE
18 2 02-05 ORANGE
19 2 02-06 ORANGE
20 2 02-07 ORANGE
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6.2 Viscosity correction

For viscosity corrected measurements the instrument has to be adjusted with the viscosity
correction set to "On". Viscosity correction is available for the DE51 (standard) or for the
DE40 (optional Memory Card).

Select "Viscosity" to be on in the Sample display as below.

(*)  This line appears only with the
DE51, or the DE40 with viscosity
correction (Memory Card.)

When working with a Sample File the viscosity correction can be chosen for each sample
individually.

The measurement display shows "Visc.", if the sample is measured with viscosity correction.

Note: When Viscosity correction
is chosen "On", the  Stability
of the measurement will be
fixed to "O".

In viscosity correction mode the instrument first waits for stability, which will be signalized
with a beep, and then starts the viscosity correction measurement.
In GLP mode the T-values without and with viscosity correction as well as the corrected
density will be printed.

           < Sample List >
No.  M    S.No.Sample ID       Vis.
  1  1     01-01   ABC On
  2  1     01-02   DEF On
  3  1     01-03   GHI On
  4  2     01-04   JKL Off
  5  2    01-05   MNO Off

0.Method-0                     01-01
Temp.( °C)   Density (g/cm 3)

Set  20.00
Cell 20.00

            Measuring
                                    1.23456Visc.

             < Sample >

   Sample No.  : [03]-[01]
   Sample ID   : [ORANGE    ]
   Viscosity    : off  on          (*)
   Exit        : [Execute]

Sample and sample file
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7. Report (password protected)

In the <REPORT> menu you can choose the format of your printout according to the
following table.

Short GLP Variable

Name X X X
Model, Serial, Version X choice
Sample No. X X choice
Date & Time X X choice
Sample ID X choice
Method No.,  Method name X choice
Meas.Temp. X X choice
Period T X choice
Meas. Data X choice
Temp. Comp. X choice
Result X X choice
Meas. Time X choice

These report parameters can be set individually for each of the 10 methods.

Report
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8. Measuring parameter (password protected)

This section describes how to set the measuring parameters for the methods. These
measuring parameters can be set for each of the 10 methods:

Parameter Default value
Method name Method-x
Measuring temperature 20.0 °C
Stability (0-2) 1
Limit Time 0 s
Sequence Off

Press the <METHOD> key.
First select the method for which you
want to set the measuring
parameters.
Press <ENTER> to confirm.

8.1 Method name

This option is used to define method names for each method. You can enter names accor-
ding to products or according to operators, depending on your needs.

- Press the <Meas.Para> key.
The default name is displayed.
Press the <CLEAR> key twice to
clear the name.
Press the <DISPLAY> key to select
the input mode of the keyboard:
A: CAPITAL LETTERS (A, B, C,...)
a:  small letters (a, b, c, d, ...)
1:  numbers (0, 1, 2, 3, ...)

Examples of method names (either by product or by operator):

Product names Operator names
Orange Smith
Grape Nelson
Lemon McNeil
Apple Gordon

. .

Enter your method name using the alphanumeric keys (max. 8 characters) and confirm with
<ENTER>.

Measuring parameters

Method 0    < Meas.Parameter >     VA

Method Name      :[Method-0]
Measurement Temp.:[ 20.00] °C
Stability        :[1]
Limit Time       :[  600]s
Sequence         : Off  On

           < Method List >
No.  Name    Temp.( °C)     Result   .
0.Method-0     20.00   d
1.Method-1     20.00   d
2.Method-2     20.00   d
3.Method-3     20.00   d
4.Method-4     20.00   d



METTLER TOLEDO  DE40/50/51 Density Meter 31

8.2 Measuring temperature

This option is used to set the measuring temperature.

Enter your measuring temperature
(from 4 °C to 70 °C, 4 °C to 90 °C
for DE40) and confirm with
<ENTER>.

Note: After changing the set temperature make sure to allow enough time for the  instru-
ment to warm up.

     To increase the temperature:          To decrease the temperature:
from to change time  from to change time

10 °C  ⇒ 20°C +10 °C 30 min 20 °C ⇒ 10°C -10°C 1 hour

20 °C  ⇒  30°C +10 °C 30 min 30 °C ⇒ 20°C -10°C 1 hour

20 °C  ⇒ 70°C +50 °C 1 hour 70 °C ⇒ 20°C -50°C 2 hours

8.3 Measurement stability

This option is used to set the measurement stability, which allows to shorten the measuring
time. See section 3.2 "Measurement principle" for more details.

Enter your stability (0, 1 or 2) and confirm with <ENTER>.

0: Maximum stability. The measured signal (T-value) has to be stable before the density is
accepted. Longest measuring time (Time-0).

1: High stability. The final T-value is extrapolated, and the density is calculated. Medium
measuring time. ( Time-1 is approximately 1/2 of Time-0) .

2: Low stability. The final T-value is extrapolated from less values, and the density is
 calculated. Lowest measuring time. ( Time-2 is approximately 1/4 of Time-0).

Note: Stability is fixed to zero when viscosity correction is active (section 6.2).

Method 0    < Meas.Parameter >    VA

Method Name      :[Method-0]
Measurement Temp.:[ 20.00] °C
Stability        :[1]
Limit Time       :[   600]s
Sequence         : Off  On

Method 0    < Meas.Parameter >    VA

Method Name      :[Method-0]
Measurement Temp.:[ 20.00] °C
Stability        :[1]
Limit Time       :[   600]s
Sequence         : Off  On

Measuring parameters
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8.4 Limit time

This option is used to set the limit time. When this time limit is reached, the measurement is
stopped and the measured value taken, even if it is not stable.

Enter the limit time (enter 0 s for no
limit time).

8.5 Sequence (sampling, drain, rinse, purge)

This option is used to set a sample sequence. This sample sequence is mainly used together
with the sampling pump ASU-DE or with the sample changer SC24. It can be used as a SOP
(Standard Operating Procedure) with the ASU-DE. This sample sequence allows you to
define sampling time, drain time, rinsing times (for two different solutions) and purge time.

Select sequence "On" with the →
key to set a sample sequence.
Confirm with <ENTER>.

Select the input mode of the
sampling time:
Set  : Manual input, time is set by

  operator.
Auto: Automatic setting of sampling

  time. (see section 8.7)
Off   : No sampling.

If you have selected "Set" you have to enter the sampling time (0 to 9999 s). For most of the
non viscous samples we recommend a sampling time of 5 s. Once you have set the sampling
time, adjust the sampling speed (Sampling Adj. control on the ASU-DE or on SC24) in order
to get the sample in with this sample time.

If you have selected "Auto" you have
to enter the "Over Sampling Rate"
and the "Sampling Limit".

Measuring parameters

Method 0    < Meas.Parameter >    VA

Method Name      :[Method-0]
Measurement Temp.:[ 20.00] °C
Stability        :[1]
Limit Time       :[   600]s
Sequence          : Off  On

Method 0    < Meas.Parameter >    VA

Sampling       : Off  Set  Auto
Sampling Time  :[   5]s
Drain          : Off  Set  Auto
Drain Time     :[  10]s
Rinse-1        : Off  Set

Method 0    < Meas.Parameter >    VA

Sampling       : Off  Set  Auto
O.S.Rate       :[  70 ]%
Sampling Limit :[  0 ]s
Drain Time     : Off  Set  Auto
Drain Time     : [  10]s

Method 0    < Meas.Parameter >    VA

Method Name      :[Method-0]
Measurement Temp.:[ 20.00] °C
Stability        :[1]
Limit Time       :[   600]s
Sequence         : Off  On
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Measuring parameters

O.S.Rate: The instrument will detect how much time it needs from starting the pump
until the sample reaches the measuring cell and will add the O.S.Rate to
this time.

Sampling Limit: This is the sampling time which should not be exceeded. After this time the
pump automatically stops.

Select the input mode of the drain
time:
Set  : Manual input, time is set by

  the operator.
Auto: Automatic setting of drain

  time. (see section 8.7).
Off   : No draining.

If you have selected "Set" you have to enter the drain time (0 to 9999 s). A typical drain time
for non-viscous samples is about 10 s to 20 s.

If you have selected "Auto" you have
to enter the Drain Rate. The
instrument will use this percentage
of the sampling time as drain time.

Select the input mode of the Rinse-1
time:
Set  : Manual input, time is set by

  operator.
Off   : No Rinse-1.

If you have selected "Set" you have to enter the Rinse-1 time (0 to 9999 s). We recommend
to use a dedicated solvent for your sample as Rinse-1 solution.

Select the input mode of the Rinse-2
time:
Set  : Manual input, time is set by

  operator.
Off   : No Rinse-2.

Method 0    < Meas.Parameter >    VA

Sampling       : Off  Set  Auto
O.S.Rate       :[  70]%
Sampling Limit :[  0]s
Drain          : Off  Set  Auto
Drain Rate     : [ 100 ]%

Method 0    < Meas.Parameter >    VA

Rinse-1        : Off  Set
Rinse-1 Time   :[  10]s
Rinse-2        : Off  Set
Rinse-2 Time   :[  10]s
Purge          : Off  Set  Auto

Method 0    < Meas.Parameter >    VA

Rinse-1        : Off  Set
Rinse-1 Time   :[  10]s
Rinse-2        : Off  Set
Rinse-2 Time   :[  10]s
Purge          : Off  Set  Auto

Method 0    < Meas.Parameter >    VA

Sampling       : Off  Set  Auto
O.S.Rate       :[  70]%
Sampling Limit :[  0]s
Drain          : Off  Set  Auto
Drain Time     : [  10 ]s
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Measuring parameters

Method 0  < Meas.Parameter >    VA

Cell Test :Off  On
Calib. :<Other STD>
STD-1 Density :[ 0.99821]
STD-2 Density :[ 1.49320]
Exit :[Execute]

If you have selected "Set" you have to enter the Rinse-2 time (0 to 9999 s). We recommend
to use a volatile solvent as Rinse-2 solution (e.g. acetone). This will allow to speed up the
purging of the measuring cell.

Select the input mode of the Purge time:

Set: Manual input, time is set by
the operator.

Off: No Purging.
Auto: Purge will stop automatically

when the cell is dry, i.e. when
the oscillation value doesn't
change anymore.

If you have selected "Set" you have to enter the Purge time (0 to 9999 s).

If "Set" or "Auto" has been selected for the purge action you can set a "Cell Test" to be
performed after the end of the drying action (purge).

Select Cell Test: "On" to perform an
automatic cell test at the end of the
purge sequence.

Enter the reliability value.

The "Cell Test" measures the density of the empty cell (air) and compares it to the theoretical
density of air at this temperature (value is stored in the instrument). A reliability value can be
entered, which stands for the maximum tolerated difference between the measured and
theoretical density of air. Its default value is 10.

A reliability of 10 means: - DE40: ±10 * 10-4 g/cm3

- DE50 and DE51: ±10 * 10-5 g/cm3

8.6 Adjustment mode (Calibration selection)

This option is used whenever you want to select special standards for adjustment. The
standard adjustment mode is with air & water.

Select Calib.:<Other STD> to
perform the adjustment with your
own density standards.
Enter the values of these two
density standards.

Method 0    < Meas.Parameter >     VA

Rinse-1      :Off   Set
Rinse-1 Time :[ 10]s
Rinse 2      :Off   Set
Rinse-2 Time  :[ 10]s
Purge:        :Off  Set   Auto

Method 0  < Meas.Parameter >    VA

Cell Test :Off  On
Reliability :[10]
Calib. :<Air & Water>
Exit :[Execute]
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Note : The Cell Test is not available if you select "Other STD". Only very accurate density
standards should be used for adjustment with other standards, otherwise your
density meter could give wrong results.

8.7 Explanation of auto-sampling and auto-draining

You have selected "Auto" for the sampling and for the draining, for example with:

Over Sampling  rate = 30%

Drain rate = 70%

If the time measured from starting the pump until the sample reaches the measuring cell
(with ASU-DE or SC24) is 10 s, then the sampling and the drain time will be:

Sampling time = 10 + (10 x 0.30) = 13 s

Drain time = 13 x 0.70 = 0.91 s

When using this oversampling rate (O.S.Rate) make sure that the measurement cell as well
as the ingoing tubings are empty and dry when you press the <MEASURE> key. The
instrument detects the sharp change of the measurement signal caused by the sample
entering the cell.

Measuring parameters
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9. Calculation parameters (password protected)

This section describes how to select the type of results (density, specific gravity,
concentration), the number of decimals for these results and how to set the parameters for
the concentration calculation. These calculation parameters can be set for each of the 10
methods.

Press the <CALC.PARA> key.

9.1 Density: d, d(t/4), d(t/t)

Select CALC.PARA - Density
Select what density should be
displayed and printed:
d: mass density (real density).
d(t/4) : relative density referred to

water at 4 °C.
d(t/t) : relative density referred to

water at the measurement
temperature.

At 20 °C:     d(t/t) = d20
20      and d(t/4) =  d4

20

9.2 Result (Density, Concentration, BRIX, ALCOHOL, USER TABLE)

Select CALC.PARA - Result.
Select which result should be
displayed and printed:
d: density, resp. d/t/t) or d(t/4),

depending on the selected
density (previous step).

Conc. : concentration.

Note : here you can also select concentration applications, if they have been previously
loaded with a Memory Card (See also section 13 "Application Memory Cards):
BRIX, ALCOHOL, USER TABLE .

Calculation parameters

Method 0  < Calc.Parameter >

     0.Density
     1.Result
     2.Temperature Compensation
     3.Decimals

Method 0     < Density >

    Density  :d  d(t/4)   d(t/t)

    Exit    :[Execute]

Method 0  < Result >

Result      :<d       >
Exit        :[Execute]
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Concentration

Select "Conc." with the → key.
Confirm with <ENTER>.

You will select this option if you want to determine the concentration of two-component
solutions, e.g. aqueous solutions of glycerol or acetone. Ask your local representative for
available concentration tables or download them from our Internet Homepage:
www.density.com .

There are two ways to program a concentration function, either by entering this function
directly (provided that this function is already known) or by entering a concentration table
(data pairs of density and corresponding concentration).

First you have to select the unit for your concentration. This unit should be the same as that
of the solution used: the instrument does not convert units.

Select your "Conc.Unit" with the →
key. Confirm with <ENTER>.
Following units are available: No
unit, %, ppm, mg/g, mg/mL, mg/L,
g/L, Eq/L, mol/L, g/cm3.

Then you have to select the concentration formula. If your concentration function is known
already, select the same function. If your concentration function is not known (input of
concentration table) select the formula which best fits your concentration. As a rule of thumb
we recommend to select A+Bx+Cx2 if you don't know which formula to select.

Case 1: Direct input of concentration function (known concentration function)

We will describe this function using an example: measurement of Apparent Extract in beer.
The function to convert density into Apparent Extract is:

Apparent Extract = -460.234 + 662.649 x d20
20  - 202.414 x [d20

20 ]2

The following steps have to be performed:

Select "%" as Conc.Unit with the →
key. Confirm with <ENTER>.

Select "A+Bx+Cxx" with the → key.
Confirm with <ENTER>.

Calculation parameters

Method 0  < Result >

Result      :< Conc.        >
Exit        :[Execute]

Method 0  < Result >

Result         : <Conc.       >
Conc.Unit      : < None     >
Conc.Formula   : <A+Bx           >
Parameter Set  : Table  Coefficient
Data Replace   : <x<-d-R  >

Method 0  < Result >

Result         : <Conc.       >
Conc.Unit      : <%      >
Conc.Formula   : < A+Bx+Cxx         >
Parameter Set  : Table  Coefficient
Data Replace   : <x<-d-R  >
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Select "Coefficient" with the → key.
Confirm with <ENTER>.

Select "x <- d" with the → key.
Confirm with <ENTER>. See also
paragraph "Constants used" on
page 41.

Enter the A, B and C values
Confirm with <ENTER>.

Now the DE40 (DE50 or DE51) has been programmed to measure APPARENT EXTRACT
in beer. Load the measuring cell with degased beer (any air bubbles would lead to wrong
results). After pressing <MEASURE>, the following values will be displayed:

During the measurement the
temperature and the concentration
are displayed.

At the end of the measurement the
final result will be displayed
(APPARENT EXTRACT
concentration).

Note :  you can select the number of
   decimal places under "Calc.
    Para.-Decimals".

Note: This concentration function can also be used to convert the density into other units,
e.g. into API degree. The function used to convert density into API degree is:

API degree = [(1/d20
20  ) - 1] x 141.5 + 10

Case 2: Input of concentration table (concentration function unknown)
We will describe this function using an example: measurement of sulfuric acid concentration
(aqueous solution). You will have to enter a concentration table (data pairs of density and
corresponding concentration), the DE40 (DE50, DE51) will determine automatically the
correct coefficients for the concentration function.

Calculation parameters

Method 0  < Result >

Result         : <Conc.       >
Conc.Unit      : <%      >
Conc.Formula   : <A+Bx+Cx 2       >
Parameter Set  : Table  Coefficient
Data Replace   : <x<-d   >

Method 0  < Result >

 A             :[ -460.234]x10[ 0]
 B             :[  662.649]x10[ 0]
 C             :[ -202.414]x10[ 0]
 Exit          :[Execute]

0.Method-0                      01-01
Temp.( °C)                    Conc.(%)

Set  20.00
Cell 20.00

            Measuring
                               1.8804

0.Method-0                      01-01
Temp.( °C)                    Conc.(%)

Set  20.00
Cell 20.00                                1.88
              Result
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Concentration table for sulfuric acid (from "Handbook of Chemistry and Physics").

Note: see our Internet Homepage
www.density.com  for other concen-
tration tables.

Select "%" with the → key. Confirm
with <ENTER>.

Select "A+Bx+Cx2" with the → key.
Confirm with <ENTER>.

Select "Table" with the → key.
Confirm with <ENTER>. The best
results are obtained if <x← d-R> is
selected for data replace (see note
on next page).

Enter the number corresponding to
the number of data pairs to be
entered (e.g. 9 in this example). Up
to 30 data pairs can be entered.

Select "Edit" with the → key.
Confirm with <ENTER>.

Enter the data pairs according to the
table.

Enter all other data pairs according
to the table.
Select "Get Parameter" with the →
key. Confirm with <ENTER>.

Calculation parameters

Method 0  < Result >

Result         : <Conc.       >
Conc.Unit      : < %      >
Conc.Formula   : < A+Bx+Cx2       >
Parameter Set  : Table  Coefficient
Data Replace   : <x<-d-R  >

Method 0  < Result >

Result         : <Conc.       >
Conc.Unit      : <%      >
Conc.Formula   : <A+Bx+Cx 2       >
Parameter Set  : Table  Coefficient
Data Replace   : <x<-d-R  >

Method 0  < Result >

Data No. (3-30) : [ 9]
Enter Conc.Table: [Execute]
Exit            : [Execute]

Method 0  < Conc.Table >
No.     Conc.       Density         .
 1    [10.0000]    [ 1.06610]
 2    [20.0000]    [ 1.13980]
 3    [30.0000]    [ 1.21910]
 4    [40.0000]    [ 1.30280]
 Edit   Clear   Get Para.   Exit

Method 0  < Conc.Table >
No.     Conc.       Density         .
 6    [60.0000]    [ 1.49870]
 7    [70.0000]    [ 1.61050]
 8    [80.0000]    [ 1.72720]
 9    [90.0000]    [ 1.81440]
 Edit   Clear   Get Para.   Exit

Concentration       d
      (in %) (at 20 °C)

1 10 1.0661
2 20 1.1398
3 30 1.2191
4 40 1.3028
5 50 1.3952
6 60 1.4987
7 70 1.6105
8 80 1.7272
9 90 1.8144
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The results of the calculation are
shown and can be printed.

Constants used
The A, B and C values are the coefficients of the selected  function. The R value is the mean
value of all the entered density values. The instrument replaces the density values with the
density minus mean value (x←d-R) to optimize the algorithm used (compute lower values).

Note: these A, B, C and R values can be used to input the concentration function directly
without having to enter the table again.
In this case R is the mean value of all density values and (x←d-R) should be
selected as "Data Replace" for the function.

Now your density meter has been programmed to measure the concentration of sulfuric acid.
Insert an aqueous solution of sulfuric acid into the measuring cell. After pressing
<MEASURE>, the following values will be displayed:

During the measurement the
temperature and the concentration
are displayed.

At the end of the measurement the
final result (sulfuric acid
concentration) will be displayed.

Note : you can select the number of
  decimal places under "Calc.
  Para.-Decimals".

Calculation parameters

 < Get Parameter >
[A+Bx+Cx 2        ]Conc
A: 5.199161x10 1

B: 1.054394x10 2

C:-3.253848x10 1

R: 1.419311                         x

0.Method-0                      01-01
Temp.( °C)                    Conc.(%)

Set  20.00
Cell 20.00

            Measuring
                               23.5176

0.Method-0                      01-01
Temp.( °C)                    Conc.(%)

Set  20.00
Cell 20.00

              Result
                                23.5
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9.3 Temperature compensation

This section describes how to set the temperature compensation. It allows to measure the
sample at one temperature and compensate the result to another temperature. There are
three main applications which use this temperature compensation:

- The sample is to viscous to be introduced into the measuring cell or even solid (e.g. paraffin).
Therefore you need to heat the sample up to get it liquid enough to introduce it into the
measuring cell (e.g. 60 °C) but you want to get the density at 15 °C.

Note: for one special application there is already an Application Memory Card available
which allows to measure OIL products at any temperature and get the density at
15 °C or 60 °F. See section 14.1 "API software" for more information.

- Speed up the measurement. For example, if your sample comes at 40 °C and you have to
get the density at 20 °C you can set the measuring temperature to 40 °C and compensate
the result to 20 °C (provided you know the slope of the density against temperature of your
specific sample).

- The reference temperature is out of the instrument range. For example if you have to get the
density at  100° C (maximum measuring temperature of the DE50 is 70 °C). You can set the
measuring temperature to 70 °C and compensate the result to 100 °C (provided you know
the slope of the density against temperature of your specific sample).

Press the <Calc.Para> key.
Select "3.Temperature Compen-
sation". Confirm with <ENTER>.

Select "On" with the → key. Confirm
with <ENTER>.

Enter the temperature at which you
want to have the result.

Calculation parameters

Method 0  < Calc.Parameter >

     0.Density
     1.Result
     2. Temperature Compensation
     3.Decimals

Method 0    < Temp.Comp>

Temp.Comp.      : Off   On
Exit            :[Execute]

Method 0    < Temp.Comp>

Temp.Comp.      : Off   On
Comp.Temp.      :[  20.00 ] °C
Temp.Formula    :<A+Bx            >
Parameter Set   :Table   Coefficient
Data No.(2-30)  : 20]
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There are two ways to program a temperature compensation function, either by entering this
function directly (provided that this function is already known) or by entering a temperature
compensation table (data pairs of temperature and corresponding density). See previous
section 9.2 Result:

Case 1: Direct input of concentration function For input of temp.comp. function

Case 2: Input of concentration table For input of temp.comp. table

9.4 Decimals

This section describes how to set the decimals for your results (d, concentration).

Press the <Calc.Para> key.
Select "3.Decimals". Confirm with
<ENTER>.

Enter the number of decimals for the
density (d) respectively specific
gravity: d(t/t), d(t/4).

Enter the number of decimals for the different other options:

Conc: Concentration (must have been previously selected under Calc.Para-Result)

BRIX: Sugar concentration (must have been previously loaded with the Application
Memory Card and selected under Calc.Para-Result)

Alcohol: Ethanol concentration (must have been previously loaded with the Application
Memory Card and selected under Calc.Para-Result)

Note: The measured values will be displayed and printed out according to the selected
settings.

Calculation parameters

Method 0  < Calc.Parameter >

     0.Density
     1.Result
     2.Temperature Compensation
     3. Decimals

Method 0     < Decimals >

    Density   (0-5):[5]
    Conc.     (0-5):[5]
    Brix      (0-3):[3]
    Alcohol   (0-3):[3]
    Exit           :[Execute]
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10. Functions (password protected)

10.1 Data File (Function 0)

This function allows to view and process the measured data. You can either do a
recalculation of measured results, statistics on the results or delete single data i.e. mark
them so that they are not considered in the statistics calculations. You can also save these
measured data on a Data Memory Card or load them from such a card for recalculation.

Select Function "0.Data File" and
confirm with <ENTER>.

The measured data are displayed,
together with the method and result
type:
- d : density
- dt : specific gravity (d(t/t)
- d4 : specific gravity (d(t/4)
- C : concentration
- Br : BRIX
- Al : ALCOHOL

Now select with the ← and → keys between <Statistics>, <Recalc.>, <Load> and <Save>
and confirm with <ENTER>.

Note 1 : If you have many data stored, press 0 to display the first 4 data (0 to 3), and 1 to 9
to display the next blocks of data (10 to 13, 20 to 23, ... 90 to 93).

Note 2 : The <Load> and <Save> options require a Data Memory Card. These options are
described separately in section 12."Data Memory Cards".

10.1.1 Statistics

The function allows to process and view the measured data statistically. You can calculate
the mean value (Mean), the standard deviation (SD) and the relative standard deviation
(RSD). The relative standard deviation is the same as the coefficient of variation (CV).

The measured data can be filtered so that useful statistical results can be obtained after a
days work. On the first level the method will give access to the respective data only. On the
second level the series number (first two-digit number of the sample number) can be chosen
for which the statistics is to be done.

Note :  If too many filters are activated it is possible that all results are excluded.

Functions

             < Function >

0. Data File        5.Set Check
1.Sample File      6.Periodic
2.Method File      7.Auto Start
3.Changer          8.CARD utility
4.Factor           9.Memory Clear

           < Data File >
 No. M.Name    Sample    Result   .
  0 Method-0   01-01 d   0.99820
  1 Method-0   01-02 d   0.99819
  2 Method-1   02-01 Br  10.81
  3 Method-1   02-02 Br  10.82
 Statis.  Recalc.   Load  Save  Exit
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After selecting <Statis.> and con-
firmation with <ENTER>, you can
select the filter to process only the
desired results: result, method no,
method name, high sample no.
Select the desired filter to be "On"
using the → key.

Now you select whether the
statistics results are to be printed
alone (Data Print "Off") or together
with a list of all the measured values
(Data Print "On").

The statistics is now shown on the
display.

To print the results of the statistics
calculation press the <PRINT> key.

Select Exit : [Execute] and confirm
with <ENTER> to exit.

10.1.2 Recalculation

This function allows to recalculate single measured values. Before you do this you have to
change the calculation formula (or calculation table) in the respective method to the desired
one (like density to BRIX, shown in this example). When you now enter the recalculation
menu the result will be shown directly according to the new calculation setting.

Select the data to be recalculated
with the <UP> and <DOWN> keys.
Select Recalc. with the ← and →
keys and confirm with <ENTER>.

Functions

           < Data File >
 No. M.Name    Sample    Result   .
  0 Method-0   01-01 d   0.99820
  1 Method-0   01-02 d   0.99819
  2 Method-1   02-01 Br  10.81
  3 Method-1   02-02 Br  10.82
 Statis .  Recalc.   Load  Save  Exit

             < Statistics >
 Result           :< Brix         >
 Method No.       :<Off>
 Method Name      :<Off>
 High Sample No.  :<Off>
 Data Print       :<Off  >
 Statistics       :[Execute]

        < Statistics Result >

     Results     :   4
     Mean        :   10.82 %
     SD          :    0.06 %
     RSD         :    0.54 %
     Exit        :[Execute]

           < Data File >
 No. M.Name    Sample    Result   .
 11 Method-5   01-01 d   1.03981
 12 Method-5   01-02 d   1.03980
 13 Method-6   02-01 Br  10.81
 14 Method-6   02-02 Br  10.82
 Statis.  Recalc.   Load  Save  Exit

<Statistics>
Date : 29/06/1998 17:29
Sample No.(High) : 01
Method No.  : 2

Results:   4
Mean   :   10.82 %
SD     :    0.06 %
RSD    :    0.54 %

Name : Quality Lab 1

       ----------------
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Functions

Press the <CALC.PARA> key.

Select "1.Result" and confirm with
<ENTER>

Select Brix with the → key and
confirm with <ENTER>

Select Function 0.Data File again
The recalculated result is shown
(from density to BRIX)

10.1.3 Data Deletion

This function allows to exclude single measured values from the statistics calculation by
marking them with an asterisk (they are not deleted from the list).

Select the data to be excluded with
the <UP> and <DOWN> keys.

Exclude this data by pressing the
<DISPLAY> key.

The excluded data is marked with an
asterisk.

0.Method-5                      01-02
Temp.( °C)              Density(g/cm3)

Set  20.00
Cell 20.00

            Recalculation
                               1.03980

Recalc.   < Calc.Parameter >

     0.Density
     1. Result
     2.Temperature Compensation
     3.Decimals

Recalc.   < Result >

Result      :< Brix       >
Exit        :[Execute]

           < Data File >
 No. M.Name    Sample    Result   .
 11 Method-5   01-01 d   1.03981
 12 Method-5   01-02 Br  10.40
 13 Method-6   02-01 Br  10.81
 14 Method-6   02-02 Br  10.82
 Statis.  Recalc.   Load  Save  Exit

           < Data File >
 No. M.Name    Sample    Result   .
  1 Method-0   01-01 d   10.81
  2 Method-0   01-02 Br   8.40
  3 Method-0   01-03 Br  10.81
  4 Method-0   01-04 Br  10.82
 Statis.  Recalc.   Load  Save  Exit

           < Data File >
 No. M.Name    Sample    Result   .
  1 Method-0   01-01 d   10.81
*  2 Method-0   01-02 Br   8.40
  3 Method-0   01-03 Br  10.81
  4 Method-0   01-04 Br  10.82
 Statis.  Recalc.   Load  Save  Exit



46 METTLER TOLEDO  DE40/50/51 Density Meter

Now you can resume the statistics calculation again and then print the results without the
marked measurements. If you selected the data print "On" the excluded measurements will
be printed with an asterisk before the sample number.

10.2 Sample File (Function 1)

This function is used normally when the instrument is operated in connection with a sample
changer.

It is automatically set to ON when a
Sample Changer has been selected
(see Function 3).

It can also be used without Sample Changer to run standard measurements always in the
same sequence. See also section 6.1 "Sample File" for more information.

10.3 Method File (Function 2)

This function is used together with a Data Memory Card to save and load a method file.

See section 12. "Data Memory
Cards" for more information.

10.4 Changer (Function 3)

Here you can define the connected sample changer (SC24 or CHG-241) or auto sampling
unit DCU-300.

Press function 3 (Changer) and confirm with <ENTER>.

Choose the desired equipment using
the → key:
None, DCU-300, SC24, SOP40,
SOP50 or CHG-241. Confirm with
<ENTER>.

When choosing the SC24 you can define whether the measuring series is started with a
calibration (On) or not (Off).

Note : Select CHG-241 if you connect a CHG-260.

           < Sample File >

     Sample File : Off  On

     Exit        : [Execute]

      < Method File >
No.   Name  Temp.( °C)   Result  .
0. ORANGE     20.0      d
1. GRAPE      20.0      d
2. LEMON      20.0      d
3. APPLE      20.0      d
     Load    Save     Exit

             < Changer >

     Changer      : < SC24    >
     Exit         : [Execute]

Functions
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Functions

Selecting Calib. "On" means that  in
the starting position there has to be
a vial with deionized water, and that
sample vials are placed after
this position. When pressing
<MEASURE>  the instrument will
first perform a calibration with air
and water. Only after this will the
sample measurement be done.

Here you can define the starting
position on the turntable. You can
select that measurements are
started at "Home" (number 1 on the
turntable) or "Current" (the actual
position on the turntable). Confirm
with <ENTER>.

10.5 Factor (Function 4)

If you know the period of oscillation T and the density of air and water for a particular
temperature, you can enter these values here manually for the calculation of the factor.

10.6 Set check (Function 5)

In this function you can set up define the substances - name, rated value and allowed
tolerances - you want to use as standard check samples either for the daily or the periodic
check.

Select function 5 - Set Check - and confirm with <ENTER>.

With the ← and → keys select either
"Daily" or "Periodic" and confirm with
<ENTER>.

             < Changer >

    Changer        : <SC24    >
    Calib .         : Off   On
    Start Position : Home  Current
    Exit           : [Execute]

             < Changer >

    Changer        : <SC24    >
    Calib.         : Off  On
    Start Position : Home  Current
    Exit           : [Execute]

             < Factor >
Temp.     :[ 20.00] °C
Air T/d   :[  845401]/[ 0.00120]
Water T/d :[ 1086417]/[ 0.99821]
Correct   :[Execute]
Factor    :[ 2.141349]
Exit      :[Execute]

             < Set Check >

  Check        :Daily   Periodic
  Standard     :[ Fl. Carbon  ]
  Ref.Value    :[    1.94796]g/cm3
  Tolerance    :[    0.00004]g/cm3
  Exit         :[Execute]
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Functions

10.6.1 Daily Check

This check is used mainly to control the working condition of the instrument. Is the instrument
really clean and dry? Did the previous operator really clean the cell after measuring his sample?

Pressing the Check key will always activate a daily check, unless a periodic check is due (see
also section 10.7).

Normally deionized or bi-distilled water is used for this purpose. Of course any other solution
can be used that suites the purpose i.e. is readily and in abundance available as well as has
a stable and well known composition.

This example uses water as daily
check solution.
The results of this daily check are
not stored in the instrument. They
are just meant to check whether the
instrument is really ready for the
next measurement.

10.6.2 Periodic Check

This check is used mainly to verify whether a new adjustment of the instrument is necessary
or not. Every adjustment of the instrument means that the instrument settings are changed.
This can be dangerous if it is not done correctly because all the measurements afterwards
will be wrong.
Pressing the check key will start a periodic check only when such a test is due according to
the settings in section 10.7.1. When no periodic check is due it will start a daily check.

So instead of actually performing frequent adjustments we suggest to perform frequent
checks with an exactly known standard solution. As long as this periodic check is done
successfully, there is no need to adjust the instrument. The results of periodic check are read
automatically in the instrument. Should the periodic check fail, the operator should carefully
clean and dry the measuring cell and then repeat the periodic check. If it still fails, then the
instrument should be adjusted again: press the <Calib.> key and follow the instructions of the
instrument.

If the periodic check fails too often even after re-adjusting the instrument - like every second
or third time - then you should contact your local supplier for servicing and closer support.

This example uses toluene as
periodic check solution.
The results of this periodic check are
stored in the instrument. They can be
retrieved under Function "6. Periodic"
and "Show Check List".

             < Set Check >

  Check        : Daily   Periodic
  Standard     :[ Water      ]
  Ref.Value    :[    0.99821]g/cm3
  Tolerance    :[    0.00008]g/cm3
  Exit         :[Execute]

             < Set Check >

  Check        :Daily   Periodic
  Standard     :[ Toluene    ]
  Ref.Value    :[    0.86683]g/cm3
  Tolerance    :[    0.00002]g/cm3
  Exit         :[Execute]
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We recommend to use our certified density standards for a periodic instrument check:

ME-51338002 Water 0.99... g/cm3 +/- 0.00001
ME-51338003 Beverage syrup 1.04... g/cm3 +/- 0.00010
ME-51338004 Dichlorotoluene 1.26... g/cm3 +/- 0.00002
ME-51338005 Fluorocarbon 1.95... g/cm3 +/- 0.00002

10.7 Periodic (Function 6)

This function is used to set the intervals of the periodic adjustment (calibration) as well as the
periodic check. This function is also used to display and print the last adjustment data and
check data stored in the instrument.

10.7.1 Periodic  Check

Select function 6 "Periodic" and confirm with <ENTER>.

The display will show the due date
for the next periodic check. This due
date is calculated automatically by
the instrument according to following
settings. Confirm with <ENTER>.

Select the periodic check (Check
Alarm) to be "On" or "Off", and
confirm with <ENTER>.

If "On" is selected, the instrument will give one of the following messages when it is turned
on: "X Days To Check" as a remainder, "Check Day" on the due date, and "Check Day Over!"
on the following days. Each of these displays will return to the "Ready" display after a while.
If "Off" is selected, the periodic check is not active i.e. whenever you press check, a daily
check is performed.
While running the instrument will not display a message, but pressing the Check key will start
a periodic check.

Enter the check interval (in days)
and confirm with <ENTER>
Note : Enter 0 Day to force a periodic
check on today's date. This will
especially be required if the periodic
check has failed, in order to perform
it again.

Functions

             < Periodic>
  Periodic         : Check  Calib.
  Next Check Date  :19/07)1998
  Check Alarm      :Off  On
  Check Interval   :[  7]day
  Show Check List  :[Execute]
  Exit             :[Execute]

             < Periodic>
  Periodic         :Check  Calib.
  Next Check Date  :19/07)1998
  Check Alarm       :Off  On
  Check Interval   :[  7]day
  Show Check List  :[Execute]
  Exit             :[Execute]

             < Periodic>
  Periodic         :Check  Calib.
  Next Check Date  :19/07)1998
  Check Alarm      :Off  On
  Check Interval   :[  7]day
  Show Check List  :[Execute]
  Exit             :[Execute]
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Functions

Select Show Check List Execute to
display the list of the last 10 checks
performed
The whole list can be printed
pressing the <PRINT> key.

The results of such a periodic check
are automatically stored in the
instrument. You can view the last 10
checks performed.
Select the data you are interested in
and press <ENTER> to get the full
data dispayed.

10.7.2 Periodic  Adjustment (Calibration)

The instrument has to be adjusted from time to time. You can either choose the time
according to your special needs i.e. perform it when the periodic check fails for example two
times successively, or you can define a certain time period after which the instrument will
remind you to repeat the adjustment.

The results of these adjustments will automatically be stored by the instrument. You can view
at any time the last 10 adjustments performed and also print out the list for documentation
purposes as described below.

Select function 6 "Periodic Calib." and confirm with <ENTER>.

The display will show the due date
for the next periodic adjustment.
This due date is calculated
automatically by the instrument
according to following settings.
Confirm with <ENTER>.

Select the periodic adjustment
(Calib. Alarm) to be "On" or "Off",
and confirm with <ENTER>.

          < Show Check List >
No.  Date    Ref.Value    Meas.     .
10  13/07    0.86683    0.86686   NG
 9   6/07    0.86683    0.86685   OK
 8  29/06    0.86683    0.86684   OK
 7  22/06    0.86683    0.86684   OK
 6  15/06    0.86683    0.86682   OK

          < Show Check List >
Date      :13/07/1998
Standard  :TOLUENE
Temp.     : 20.00 °C
Ref.Value : 0.86683  (+- 0.00002)
Meas.Data : 0.88686  (NG)
Exit      :[Execute]

             < Periodic>
  Periodic         :Check  Calib .
  Next Calib.Date  :19/07)1998
  Calib.Alarm      :Off  On
  Calib.Interval   :[  7]day
  Show Calib.List  :[Execute]
  Exit             :[Execute]

             < Periodic>
  Periodic         :Check  Calib.
  Next Calib.Date  :19/07)1998
  Calib.Alarm      :Off  On
  Calib.Interval   :[  7]day
  Show Calib.List  :[Execute]
  Exit             :[Execute]

             < Periodic>
  Periodic         :Check  Calib.
  Next Calib.Date  :19/07)1998
  Check Alarm      :Off  On
  Check Interval   :[  7]day
  Show Check List  :[Execute]
  Exit             :[Execute]
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Functions

If "On" is selected, the instrument will give one of the following messages when it is turned on:
"X Days to Calib" as a remainder, "Calib. Day" on the due date, and "Calib. Day Over!" on the
following days. Each of these displays will return to the "Ready" display after a while.
If "Off" is selected, the instrument will not remaind you to readjust.

Enter the adjustment interval (in
days) and confirm with <ENTER>.

Note : Enter 0 Day to force a periodic
  adjustment on today's date.

Select Show Calib.List Execute to
display the list of the last 10
adjustments performed.

The results of such a periodic
adjustment are automatically stored
in the instrument. You can view the
last 10 adjustments performed.
Select the data you are interested in
and press <ENTER>.

By pressing the print key the whole
list is printed.

10.8 Auto Start (Function 7)

This function is used mainly for repetitive measurements in one sample. It can not be turned
on when there is a connection to a sample changer or to a DCU.

Press <Function> 7 and confirm with
<ENTER>.

Select "On" or "Off" and confirm with
<ENTER>.

< Periodic>
  Periodic         :Check  Calib.
  Next Check Date  :19/07)1998
  Calib. Alarm      :Off  On
  Calib.Interval   :[  7]day
  Show Calib.List  :[Execute]
  Exit             :[Execute]

< Periodic>
  Periodic         :Check  Calib.
  Next Calib.Date  :19/07)1998
  Calib.Alarm      :Off  On
  Calib.Interval   :[  7]day
  Show Calib.List  :[Execute]
  Exit             :[Execute]

          < Show Calib.List >
No.  Date    Temp.( °C)   Factor     .
10  13/07      20.00    2.142349  OK
 9   6/07      20.00    2.142342  OK
 8  29/06      20.00    2.142337  OK
 7  22/06      20.00    2.142338  OK
 6  15/06      20.00    2.142335  OK

          < Show Calib.List >
Date      :13/07/1998
Temp.     : 20.00 °C
Air       :T=   845401  d= 0.00120
Water     :T=  1086417  d= 0.99821
Factor    : 2.142349 (OK)
Exit      :[Execute]

           < Auto Start >

   Auto Start      :Off  On
   Exit            :[Execute]
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When you have chosen "On", you
can define the time interval between
two measurements. Confirm with
<ENTER>. Enter 0 to start the next
measurement imme-diately after the
end of the actual measurement (no
time interval).

In "Meas. Times" you define the number of repetitive measurements to be performed with
this sample. Enter 0 for continuous measurement. In this case press Reset to stop the
measurements.

10.9 CARD Utility (Function 8)

This function is used together with the Memory Cards.

See section 12 "Data Memory Cards" and section 13 "Application Memory Cards" for more
information.

           < CARD Utility >

0.Data Delete      5.Table Capacity
1.Sample Delete    6.Install Table
2.Method Delete    7.Uninstall Table
3.Format
4.CARD Information

Functions

           < Auto Start >

   Auto Start      :Off  On
   Interval Time   :[    10]min
   Meas.Times      :[ 0]
   Exit            :[Execute]
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           < Memory Clear >

0.Measured Data    4.Method Parameter
1.Sample File      5.All Parameter
2.Periodic Check
3.Periodic Calib.

        < Measured Data Clear >

      Clear Execute ?  No  Yes

10.10 Memory Clear (Function 9)

This function is used to reset all parameters to default (factory setting), for instance to
initialize the memory after a serious malfunction of the instrument.

You can also selectively reset single records like the adjustment data (Calib. data), the check
records, the sample files or the method parameters.

Press <Function> 9 and confirm with
<ENTER>.

Select the desired option:
"Measured Data", "Sample File",
"Periodic Check", "Periodic Calib.",
"Method Para.", "All Parameter", and
confirm your choice with <ENTER>.

Select "Yes" to confirm your choice
again and press <ENTER>.

The chosen data or parameters are now deleted and the respective factory settings are
active again.

Note : The function "5. All Parameter" doesn't delete any downloaded special application
tables (from flash memory cards).

Functions
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11. Setup (password protected)

11.1 Interface (Setup 0)

This option is used to define the RS-232C serial interface and the serial printer.

Press the <SETUP> key.
Select "0.Interface". Confirm with
<ENTER>.

Select "Printer" with the → key in
order to setup the printer or
"RS-232C" to define the serial
interface.

11.1.1 RS-232C Interface setup

This option is used to setup the RS-232C interface either for connecting a computer or for
connecting a RE40 or RE50 refractometer for simultaneous measurement of refractive index
and density (or specific gravity). In both cases you have to make sure that the other
equipment (computer or RExx) is setup with the same values.

Select the following values according to your computer setup or to your RE40 resp. RE50
setup. In case you connect a RExx refractometer, use "Setup 0: Interface" at the
refractometer to make sure that both setups are identical.

Setup

             < Setup >

0. Interface        5.International
1.Date & Time      6.Lock
2.Name             7.Beep
3.Serial/Version   8.Temperature
4.LCD Contrast

           < Interface >

           0.RS-232C
           1.Printer

           < RS-232C >

    Baud Rate  :<4800>
    Parity     :Even  Odd  None
    Stop Bits  :1  2
    Data Bits  :7  8
    Exit       :[Execute]
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11.1.2 Printer setup

We recommend to select the GA42 printer from METTLER TOLEDO. Make sure that the DIP
switch 2 is ON on the GA42 printer.

The following printers are predefined:

GA-: for GA42 and SPRINTER printer from METTLER TOLEDO.
Other : for all serial printers. Selection of:

- Baud rate (300, 600, 1200, 2400,....)
- Parity (none , even, odd)
- Stop bits (1, 2)
- Data bits (7, 8)
These parameters have to be set according to the specifications of
your printer.
The bold settings are active for the GA42 printer.

IDP-: not used
DP-: not used

11.2 Date and Time (Setup 1)

This option is used to enter the actual date and time.

Press the <SETUP> key.
Select "1.Date&Time". Confirm with
<ENTER>.

Actual date and time are displayed.
Press <ENTER> key.
Enter date and time (the date format
is selected in the menu Setup
„5.International”) and confirm with
<ENTER>.

Setup

           < Printer >

 Printer   :IDP-  DP-  GA-  Other
 Exit      :[Execute]

             < Setup >

0.Interface        5.International
1. Date & Time      6.Lock
2.Name             7.Beep
3.Serial/Version   8.Temperature
4.LCD Contrast

           < Date & Time >

          12/07/1998  17:12

 Day   :[12]     Hour    :[17]
 Month :[ 7]     Minutes :[12]
 Year  :[1998]   Exit    :[Execute]
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Setup

11.3 Name (Setup 2)

This option is used to enter the laboratory name (or company or operator).

Press the <SETUP> key.
Select "2.Name". Confirm with
<ENTER>.

The capital A  means that the
alphanumerical keyboard is in entry
mode for capital letters. Press the
<DISPLAY> key to change the entry
mode:
A: capital letters (A, B, C, D, ..)
a: small letters (a, b, c, d, ...)
1: numbers (0, 1, 2, 3, 4, ...)

11.4 Serial/Version number (Setup 3)

This option is used to identify the software version and the serial number of your instrument
without having to switch off the instrument.

- Press the <SETUP> key.

Select "3.Serial/Version".

Press the <ENTER> key. The serial
number of your instrument as well
as the software version are
displayed.

             < Setup >

0.Interface        5.International
1.Date & Time      6.Lock
2. Name             7.Beep
3.Serial/Version   8.Temperature
4.LCD Contrast

             < Name >              A

  Name  :[Quality Lab 1  ]

  Exit  :[Execute]

             < Setup >

0.Interface        5.International
1.Date & Time      6.Lock
2.Name             7.Beep
3. Serial/Version   8.Temperature
4.LCD Contrast

      < Serial No./Version No.>

  Serial No.    :  xxxxxxxx
  Version No.   :  x.xx

               [Exit]
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11.5 LCD Contrast (Setup 4)

This option is used to adjust the contrast of the LCD display in your instrument.

Press the <SETUP> key.
Select "4.LCD Contrast".
Confirm with <ENTER>.

Select the LCD contrast with the ←
and → keys. Confirm with
 <ENTER>.

11.6 International (Setup 5)

This option is used to select the date format and the unit for the temperature.

Press the <SETUP> key.
Select "5.International".
Confirm with <ENTER>.

Select your date format with the →
key: YYYY: Year

MM  : Month
DD    : Day

Select your temperature unit with the
→ key: °C : degree Celsius

°F : degree Fahrenheit

Setup

           < LCD Contrast >

 Light          Center         Dark
  <|  |  |  |  |  |  |  |  |  |  |>

             < Setup >

0.Interface        5. International
1.Date & Time      6.Lock
2.Name             7.Beep
3.Serial/Version   8.Temperature
4.LCD Contrast

          < International >

  Date       :<DD/MM/YYYY>
  Temp.Unit  : °C  °F
  Exit       :[Execute]

             < Setup >

0.Interface        5.International
1.Date & Time      6.Lock
2.Name             7.Beep
3.Serial/Version   8.Temperature
4. LCD Contrast
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11.7 Lock with password (Setup 6)

Press the <SETUP> key.

Select "6.Lock".
Confirm with <ENTER>.

Select "On" with the → key.
Confirm with <ENTER>.

Enter your password. Make sure to
keep it in a safe place in case you
would forget it.
Enter your password a second time
to confirm the correct spelling.

In case you would have forgotten your password you will need to call the METTLER
TOLEDO service.

11.8 Beep (Setup 7)

Press the <SETUP> key.
Select "7.Beep".
Confirm with <ENTER>.

Select "On" with the → key.
Confirm with <ENTER>.

Enter your beep selection:
Type1: long and fast
Type2: long and slow
Type3: short and fast
Type4: short and slow

Setup

             < Setup >

0.Interface        5.International
1.Date & Time      6.Lock
2.Name             7. Beep
3.Serial/Version   8.Temperature
4.LCD Contrast

             < Beep >

   Beep          :Off   On
   Beep Type     :<Type1>
   Exit          :[Execute]

             < Setup >

0.Interface        5.International
1.Date & Time      6. Lock
2.Name             7.Beep
3.Serial/Version   8.Temperature
4.LCD Contrast

          < Password Lock >

   Password Lock     :Off   On
   Password          :[********]
   Confirm Password  :[********]
   Lock Execute      :[Execute]
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             < Setup >

0.Interface        5.International
1.Date & Time      6.Lock
2.Name             7.Beep
3.Serial/Version   8. Temperature
4.LCD Contrast

          < Temperature >

          0.Calibration
          1.Adjust

11.9 Temperature calibration (Setup 8)

Press the <SETUP> key.
Select "8.Temperature".
Confirm with <ENTER>.

Select either "1.Adjust" (single point)
or "0.Calibration" (multiple point over
the hole temperature range).
Confirm with <ENTER>.

Adjust:
Performs a one-point adjustment at the measuring temperature (correcting the offset).
Select this option when the difference between Set Temperature and Cell Temperature is
less than 0.5 °C (in equilibrium).

Calibration:
Performs a multiple point adjustment, in steps of 5 °C, over the entire temperature range.
Select this option when the difference between Set Temperature and Cell Temperature is
0.5 °C or higher  (in equilibrium). This temperature calibration takes approximately two hours!
This temperature calibration will adjust the internal thermistors to the certified thermistor in
the measuring cell over the whole temperature range.

Setup
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12. Memory Cards (DE40, DE50 and DE51)

The following two sections describe the use of the memory cards. There are two types of
memory cards to be used with the DE40, DE50 and DE51 density meters:

Data Memory Card: SRAM cards.
For measurement data, methods and sample files (ME-51324004).

Application Memory Card: FLASH cards.
For the following applications:

•  ALCOHOL (ME-51324000)
•  BRIX (ME-51324001)
•  API (ME-51324002)
•  VISCOSITY CORRECTION (ME-51324003)
•  CONCENTRATION TABLES (ask your local representative)

12.1 Data Memory Cards: data, methods, sample files

These Data Memory Cards are SRAM cards, have a capacity of 1 MB and use a lithium
battery. The cards are used to store measurement data, methods or/and sample files. You
can store up to:

982 Methods (if only methods are stored),

498 Sample files (if only sample files are stored),

10 Data files, each file containing up to 100 data (if only data files are stored).

If you store a combination of methods, sample files and data files the number of available
free space will decrease. In order to see how much free space is available, perform following
steps:

Press the <FUNCTION> key.
Select “8.CARD utility”. Confirm with
<ENTER>
Insert a Data Memory Card into the
slot on the front left part of the
instrument.

Select “4.CARD Information”.
Confirm with <ENTER>.

Data Memory Card

        < Function >

0.Data File     5.Set Check
1.Sample File   6.Periodic
2.Method File   7.Auto Start
3.Changer       8. CARD utility
4.Factor        9.Memory Clear

         < CARD utility >

0.Data delete     5.Table Capacity
1.Sample delete   6.Install Table
2.Method delete   7.Uninstall Table
3.Format
4. CARD Information
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12.2 Save measured data

With the Data Memory Card you can save data on the card or load data from the card. The
DE40, DE50 and DE51 store up to 100 measurement data in the internal memory. These
data can be saved on a memory card as one single data file. Let’s assume that you have
already performed 35 measurements.

Press the <FUNC> key.

Select “0.Data File”. Confirm with
<ENTER>.

Note : If you have many data stored, press 0 to display the first 4 data (0 to 3), and 1 to 9 to
display the next blocks of data (10 to 13, 20 to 23, ... 90 to 93).

Insert a Data Memory Card into the slot on the front left part of the instrument.

Select “Save” with the → key. Confirm with <ENTER>.

Enter the name under which you
want to store the measurement data
(max. 8 characters).
Note : Blank spaces are not allowed.

Press <ENTER> twice (confirm
Save Execute and Exit).

Data Memory Card

       < Card Information >
   Type           Used    Unused.
Method File    :   [   0]  [ 982]
Sample File    :   [   0]  [ 498]
Meas.Data File :   [   0]  [  10]

             [Exit]

          < Function >

0. Data File      5.Set Check
1.Sample File   6.Periodic
2.Method File   7.Auto Start
3.Changer       8.CARD utility
4.Factor        9.Memory Clear

          < Data File >
No.   M.Name   Sample   Result  .
32 ORANGE      01-10 d     1.0326
33 GRAPE       02-01 d     1.0024
34 GRAPE       02-02 d     1.0025
35 GRAPE       02-03 d     1.0024
Statis.  Recalc.  Load  Save  Exit

       < Save Data File >

    File Name    : [WEEK24  ]
    Save Execute : [Execute]
    Exit         : [Execute]
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Wait until all data have been saved.

Press <ENTER>.

Your data are now saved on the memory card, you can clear the internal memory of the
instrument (see next section).

12.3 Clear measured data

Let’s assume that you have saved the previously performed 35 measurements (previous
section). Once your data are saved on the memory card you can clear the internal memory of
the instrument.

Press the <FUNC> key.

Select “9.Memory Clear”. Confirm
with <ENTER>.

Select “0.Measured Data”. Confirm
with <ENTER>.

Select “Yes” with the → key. Confirm
with <ENTER>.
A beep sound will indicate that the
memory has been cleared.

Data Memory Card

         < Save Data File >

            Now Saving ...

        File save is complete

              [ OK ]

        < Function >

0.Data File     5.Set Check
1.Sample File   6.Periodic
2.Method File   7.Auto Start
3.Changer       8.CARD utility
4.Factor        9. Memory Clear

         < Memory Clear >

0. Measured Data  4.Method Parameter
1.Sample File    5.All Parameter
2.Periodic Check
3.Periodic Calib.

       < Memory Data Clear >

   Clear Execute ?  No   Yes
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12.4 Load measured data

This may be used for example to recalculate some results you have already stored on a
Memory Card. Press the <FUNC> key.

Select “0.Data File”. Confirm with
<ENTER>.

Insert the Data Memory Card with
the previously stored data into the
slot on the front left part of the
instrument.
Select “Load”. Confirm with
<ENTER>.

Select the Data File you want to load
with the <UP> and <DOWN> keys.
Confirm with <ENTER>.

Select “Yes” with the → key.
Confirm with <ENTER>.

Wait until the data file has been
loaded.

Press <ENTER>.

Data Memory Card

        < Function >

0. Data File      5.Set Check
1.Sample File   6.Periodic
2.Method File   7.Auto Start
3.Changer       8.CARD utility
4.Factor        9.Memory Clear

         < Data File >
No.   M.Name   Sample   Result

           Data not exist.

         Exit         Load

        < Load Data File >
File Name     Date        Time
WEEK24     06/12/1998    18:02
WEEK23     06/05/1998    18:14
WEEK22     05/29/1998    17:25
WEEK21     05/22/1998    17:45
WEEK20     05/15/1998    18:25

        < Load Data File >

       File will be loaded.

               OK ?

              No  Yes

       < Load Data File >

          Now Loading ...

       File load is complete

             [ OK ]
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You can now display the loaded
data. Press the <FUNC> key.

Select “0.Data File”. Confirm with
<ENTER>.

Note : if you have many data stored, press 0 to display the first 4 data (0 to 3), and 1 to 9 to
display the next blocks of data (10 to 13, 20 to 23, ... 90 to 93).

12.5 Save method

With the Data Memory Card you can save methods on the card or load methods from the
card. The DE40, DE50 and DE51 store up to 10 methods in the internal memory. These
methods can be saved on a memory card and transferred to another instrument. This is
especially useful to develop a method in a central laboratory and once this method has been
validated to distribute it to all other laboratories.

Press the <FUNC> key.

Select “2.Method File”. Confirm with
<ENTER>.

Select the method you want to save
with the <UP> and <DOWN> keys.
Select “Save” with the → key.
Confirm with <ENTER>.

Enter the name under which you
want to store the method (max. 8
characters).

Press <ENTER> twice (confirm
Save Execute and Exit).

        < Function >

0. Data File      5.Set Check
1.Sample File   6.Periodic
2.Method File   7.Auto Start
3.Changer       8.CARD utility
4.Factor        9.Memory Clear

         < Data File >
No.   M.Name   Sample   Result  .
32 ORANGE      01-10 d     1.0326
33 GRAPE       02-01 d     1.0024
34 GRAPE       02-02 d     1.0025
35 GRAPE       02-03 d     1.0024
Statis.  Recalc.  Load  Save Exit

Data Memory Card

        < Function >

0.Data File     5.Set Check
1.Sample File   6.Periodic
2. Method File    7.Auto Start
3.Changer       8.CARD utility
4.Factor        9.Memory Clear

         < Method File >
No.   Name  Temp.( °C)   Result  .
0. ORANGE     20.0      d
1. GRAPE      20.0      d
2. LEMON      20.0      d
3. APPLE      20.0      d
     Load    Save     Exit

      < Save Method File >

    File Name    : [GRAPE   ]
    Save Execute : [Execute]
    Exit         : [Execute]
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Wait until method has been saved.

Press <ENTER>.

12.6 Clear internal method

Let’s assume that you have saved the previously defined methods (previous section). Once
your methods are saved on the memory card you can clear the internal memory of the
instrument.

Press the <FUNC> key.

Select “9.Memory Clear”. Confirm
with <ENTER>.

Select “4.Method Parameter”.
Confirm with <ENTER>.

Select “Yes” with the → key.
Confirm with <ENTER>.
A beep sound will indicate that the
memory has been cleared.

       < Save Method File >

          Now Saving ...

       File save is complete

             [ OK ]

Data Memory Card

        < Function >

0.Data File     5.Set Check
1.Sample File   6.Periodic
2.Method File   7.Auto Start
3.Changer       8.CARD utility
4.Factor        9. Memory Clear

         < Memory Clear >

0.Measured Data  4. Method Parameter
1.Sample File    5.All Parameter
2.Periodic Check
3.Periodic Calib.

     < Method Parameter Clear >

   Clear Execute ?  No   Yes
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12.7 Load method

Press the <FUNC> key.

Select “2.Method File”. Confirm with
<ENTER>.

First you have to select where you
want to load the method. Select the
method you want to overwrite with
the one to be loaded with the <UP>
and <DOWN> keys.
Select “Load” with the → key.
Confirm with <ENTER>.

Select the method you want to load
with the <UP> and <DOWN> keys.
Confirm with <ENTER>.

Select “Yes” with the → key and
confirm with <ENTER>.

Wait until the method has been
loaded.

Press <ENTER>.

        < Function >

0.Data File     5.Set Check
1.Sample File   6.Periodic
2. Method File    7.Auto Start
3.Changer       8.CARD utility
4.Factor        9.Memory Clear

         < Method File >
No.   Name  Temp.( °C)   Result  .
0. Method-0    20.0      d
1. Method-1    20.0      d
2. Method-2    20.0      d
3. Method-3    20.0      d
     Load    Save     Exit

        < Load Method File >
File Name     Date        Time  .
GRAPE      06/12/1998    18:02
LEMON      06/05/1998    18:14
APPLE      05/29/1998    17:25
ORANGE     05/22/1998    17:45
SPRITE     05/15/1998    18:25

        < Load Method File >

       File will be loaded.

               OK ?
              No  Yes

       < Load Method File >

          Now Loading ...

       File load is complete

             [ OK ]

Data Memory Card
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Repeat the previous steps if you
want to load more methods, being
careful not to overwrite an already
defined method: select a free
method “Method-x” to be
overwritten.

Select “Exit” with the → key. Confirm
with <ENTER>.

12.8 Save sample file

With the Data Memory Card you can save sample files to the card or load sample files from
the card. The DE40, DE50 and DE51 store up to 498 sample files in the internal memory.
These sample files are usually used together with the sample changer, in order to run
samples according to a predefined sequence (sample names, method to be used, etc...).
They can also be used as a SOP (Standard Operating Procedure) if no sample changer is
connected. See section 6.1 for the description of sample files. Let’s assume that you have
already defined such a sample file.

Press the <FUNC> key.

Select “1.Sample File”. Confirm with
<ENTER>.

Select “On” with the → key. Confirm
with <ENTER>.

Press the <SAMPLE> key.

Select “Save” with the → key.
Confirm with <ENTER>.

         < Method File >
No.   Name  Temp.( °C)   Result  .
0. Method-0    20.0      d
1. ORANGE      20.0      d
2. Method-2    20.0      d
3. Method-3    20.0      d
     Load    Save     Exit

         < Method File >
No.   Name  Temp.( °C)   Result  .
0. Method-0    20.0      d
1. ORANGE      20.0      d
2. Method-2    20.0      d
3. Method-3    20.0      d
     Load    Save     Exit

Data Memory Card

        < Function >

0.Data File     5.Set Check
1. Sample File    6.Periodic
2.Method File   7.Auto Start
3.Changer       8.CARD utility
4.Factor        9.Memory Clear

        < Sample File >

    Sample File  : Off   On

    Exit         : [Execute]

           < Sample >
Sample File     :Skip  Load  Save
Max.Meas.No.    :[ 24]
Next Meas.No.   :[  1]
Method          :Current Variable
Set Parameter   :[Execute]
Exit            :[Execute]
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Enter the name under which you
want to store the sample file (max. 8
characters).

Press <ENTER> twice (confirm
Save Execute and Exit).

Wait until:

Press <ENTER>.

12.9 Clear internal sample file

Let’s assume that you have saved the previously defined sample file (previous section).
Once your sample file is saved on the memory card you can clear the internal memory of the
instrument.

Press the <FUNC> key.

Select “9.Memory Clear”. Confirm
with <ENTER>.

Select “1.Sample File”. Confirm with
<ENTER>.

Select “Yes” with the −> key.
Confirm with <ENTER>.
A beep sound will indicate that the
memory has been cleared.

      < Save Sample File >

    File Name    : [COKE24  ]
    Save Execute : [Execute]
    Exit         : [Execute]

       < Save Sample File >

          Now Saving ...

       File save is complete

             [ OK ]

        < Function >

0.Data File     5.Set Check
1.Sample File   6.Periodic
2.Method File   7.Auto Start
3.Changer       8.CARD utility
4.Factor        9. Memory Clear

         < Memory Clear >

0.Measured Data  4.Method Parameter
1. Sample File     5.All Parameter
2.Periodic Check
3.Periodic Calib.

      < Sample File Clear >

   Clear Execute ?  No   Yes

Data Memory Card
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12.10 Load sample file

Press the <SAMPLE> key.

Select “Load” with the → key.
Confirm with <ENTER>.

Select the sample file you want to
load with the <UP> and <DOWN>
keys. Confirm with <ENTER>.

Select “Yes” with the → key.
Confirm with <ENTER>.

Wait until the sample file has been
loaded.

Press <ENTER>.

Data Memory Card

           < Sample >
Sample File    :Skip  Load  Save
Max.Meas.No.   :[ 24]
Next Meas.No.  :[  1]
Method         :Current Variable
Set Parameter  :[Execute]
Exit           :[Execute]

        < Load Sample File >
File Name     Date        Time  .
COKE24     06/12/1998    18:02
COKE10     06/05/1998    18:14
SPRITE24   05/29/1998    17:25
SPRITE10   05/22/1998    17:45
LIGHT24    05/15/1998    18:25

       < Load Sample File >

       File will be loaded.

               OK ?
              No  Yes

       < Load Sample File >

          Now Loading ...

       File load is complete

             [ OK ]
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13. Application Memory Cards: BRIX, ALCOHOL, API, VISCOSITY
CORRECTION, USER TABLES

These Application Memory Cards are FLASH cards with a capacity of 2 MB. The cards are
used to download special applications to your instrument. Once the application has been
downloaded to the instrument it is removed from the Application Memory Card. In other
words the Memory Card is empty, but can still be used to retrieve the application from the
instrument, for example to transfer it to another instrument. Therefore make sure to keep the
empty Application Memory Card in a safe place.

Note : The function "Memory Clear" "All Parameter" (in Function 9.5) doesn’t clear the
downloaded application.

13.1 How to download an application (Install table)

This section will show you how to download an application. Following Application Memory
Cards are available:

•  ALCOHOL Alcohol concentration (Ethanol) (ME-51324000)
•  BRIX Sugar concentration (Sucrose) (ME-51324001)
•  API Petroleum products (ME-51324002)
•  VISCOSITY Viscosity correction (ME-51324003)
•  CONCENTRATION TABLES (ask your local representative)

Insert the Application Memory Card into the slot on the front left part of the instrument.

Press the <FUNC> key.
Select “8.CARD utility”. Confirm with
<ENTER>.

Select “6.Install Table”. Confirm with
<ENTER>.

Note : The following shows the BRIX application. For other applications just replace BRIX
with your application (Alcohol, API, Viscosity correction, Concentration).

Select the application to load with
the <UP> and <DOWN> keys.
Select “Install” with the −> key.
Confirm with <ENTER>.

Application Memory Card

< Function >

0.Data File     5.Set Check
1.Sample File   6.Periodic
2.Method File   7.Auto Start
3.Changer       8. CARD utility
4.Factor        9.Memory Clear

         < CARD utility >

0.Data delete     5.Table Capacity
1.Sample delete   6. Install Table
2.Method delete   7.Uninstall Table
3.Format
4.CARD Information

< Install Table >
Table  Name  Type   Temp.  Data.
 Brix        Conc.  20.00 °C   85

        Exit     Install
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Wait until the installation has been
done.

Press <ENTER>.

The asterisk (*) on the left of the
application (BRIX) shows that this
application has been downloaded
and removed from the Memory
Card. This means that the Memory
Card is empty, but can still be used
to retrieve the application from the
instrument (uninstall table).

13.2 How to select the application

The application has been downloaded to the instrument. You need now to define which
method should be dedicated to this application.

Press <METHOD>.

Select the method you want to
dedicate to this application with the
<UP> and <DOWN> keys. Confirm
with <ENTER>.
Press the <MEAS.PARA> key.

Set the measurement parameters
according to your application (see
section 8).

There are now three different selections, depending on the application:

1. Select concentration table: ALCOHOL, BRIX, CONCENTRATIONS.

2. Select temperature table: API.

3. Select viscosity correction: see section 6.2.

       < Install Table >

          Now Install ...

    Table install is complete

             [ OK ]

        < Install Table >
Table Name  Type   Temp.  Data.
*Brix       Conc.  20.00 °C   85

        Exit      Install

Application Memory Card

         < Method List >
No.   Name  Temp.( °C)   Result  .
0. Method-0    20.0      d
1. Method-1    20.0      d
2. Method-2    20.0      d
3. Method-3    20.0      d
4. Method-4    20.0      d

Method 1 <Meas.Parameter>

Method Name      :[ORANGE]
Measurement Temp.:[ 20.00] °C
Stability (0-2)  :[1]
Limit Time       :[  600]s
Sequence         :Off  On
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13.2.1 Select a concentration table: ALCOHOL, BRIX, CONCENTRATIONS

Press the <CALC.PARA> key.

Select “1.Result”. Confirm with
<ENTER>.

Select “Brix” (Alcohol,
Concentration, according to your
application). Confirm with
<ENTER>.

Press <ENTER> (confirm Execute).
Press <METHOD>.

The method list now should show
you the selected method with the
corresponding application.

13.2.2 Select a temperature table: API

Press the <CALC.PARA> key.

Select “2.Temperature
Compensation”. Confirm with
<ENTER>.

Select “Oil Table-1” (Oil Table-2 or
Oil Table-3, according to your
application) with the → key. See
also section 14.1. Confirm with
<ENTER>.

Press <RESET>.

Application Memory Card

Method 1 <Calc.Parameter>

    0.Density
    1. Result
    2.Temperature Compensation
    3.Decimals

Method 1 <Result>

Result      :< Brix         >
Exit        :[Execute]

         < Method List >
No.   Name  Temp.( °C)   Result  .
0. Method-0    20.0      d
1. ORANGE      20.0      Brix
2. Method-2    20.0      d
3. Method-3    20.0      d
4. Method-4    20.0      d

Method 1 <Calc.Parameter>

    0.Density
    1.Result
    2. Temperature Compensation
    3.Decimals

Method 1 <Temp.Comp.>

Temp.Comp      : Off   On
Comp.Temp.     :[20.00] °C
Temp.Formula   :< Oil Table-1 >
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13.3 How to retrieve an application (Uninstall table)

This section will show you how to retrieve an application from the instrument, for example to
transfer it to another instrument.

Insert the empty Application Memory Card into the slot on the front left part of the instrument.

Press the <FUNC> key.

Select “8.CARD utility”. Confirm with
<ENTER>.

Select “7.Uninstall Table”. Confirm
with <ENTER>.

Select “0.Conc.Table ” if your appli-
cation is a concentration table:
BRIX, ALCOHOL, CONCENTRATION,
or select “1.Temp.Table ” if your
application is a temperature table:
API.
Confirm with <ENTER>.

The asterisk (*) on the left of the application (BRIX) shows that this application has been
downloaded and removed from the Memory Card. This means that the Memory Card is
empty, but can still be used to retrieve the application from the instrument.

Select the application to uninstall
with the <UP> and <DOWN> keys.
Select “Uninstall” with the -> key.
Confirm with <ENTER>.

Wait until the application has been
uninstalled.

        < Function >

0.Data File     5.Set Check
1.Sample File   6.Periodic
2.Method File   7.Auto Start
3.Changer       8. CARD utility
4.Factor        9.Memory Clear

         < CARD utility >

0.Data delete     5.Table Capacity
1.Sample delete   6.Install Table
2.Method delete   7. Uninstall Table
3.Format
4.CARD Information

      < Uninstall Table >

         0.Conc.Table
         1.Temp.Table
         2.Exit

Application Memory Card

        < Uninstall Table >
Table Name  Type   Temp.  Data.
*Brix       Conc.  20.00 °C   85

        Exit      Uninstall

       < Uninstall Table >

          Now Uninstall ...
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Press <ENTER>.

Select “2.Exit” and confirm with
<ENTER>.
The table on the Memory Card is no
longer marked by an asterisk (*).

   Table uninstall is complete

             [ OK ]

      < Uninstall Table >

         0.Conc.Table
         1.Temp.Table
         2. Exit

Application Memory Card
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Special application cards

14. Description of the special applications:
BRIX, ALCOHOL, API, VISCOSITY CORRECTION, COKE, USER
TABLES

The standard software of the DE40/50/51 can be expanded by various software options
(METTLER TOLEDO Service) that are available on Memory Card. This allows you to match
the selection of the method parameters to your requirements.

14.1 API software

The density of crude oils, oil products or lubricants must in some cases be measured at
elevated temperatures owing to their viscosity. With this software, stored tabulated values
are used for the automatic conversion of this density to that at 15 °C or 60 °F, depending on
the temperature unit you measure with. The tabulated values are based on API standard
2540 (API: American Petroleum Institute).
Under the parameters of the temperature compensation, select the required oil table (see
Section 9.2 and 14.4).

Oil table 1: the density of crude oils is converted to the reference temperature of 15° C
(or 60° F) according to table 53A of the API standard.

Oil table 2: the density of oil products is converted to the reference temperature of
15° C (or 60° F) according to table 53B of the API standard.

Oil table 3: the density of lubricants is converted to the reference temperature of
15° C  (or 60° F) according to table 53D of the API standard.

To calculate the "API degrees", enter "((1/d) – 1) * 141.5 + 10" as concentration function (see
Section 9.2 and 14.6).

14.2 Alcohol software

With this software the measured density of an alcoholic solution can be converted to the
corresponding volume concentration of Ethanol in water i.e. % v/v. Two different conversion
tables exist for  this conversion, depending on the physical unit the temperature is measured
(and the reference temperature):

14.2.1 Temperature measured in °F, with a reference temperature at 60 °F:

This option is activated by selecting the temperature unit °F (see Section 11.6). The stored
values are based on table 3 of NBS Circular 19 (NBS: National Bureau of Standards, since
1988: National Institute of Standards and Technology). You must perform your
measurements at 60 °F to obtain the correct ethanol content.
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14.2.2 Temperature measured in °C, with a reference temperature at 20 °C:

This option is activated by selecting the temperature unit °C (see Section 11.6). The stored
values are based on table IVa of OIML Guideline No. 22 (OIML: Organisation Internationale
de Métrologie Légale). You must perform your measurements at 20 °C to obtain the correct
ethanol content.

Under the parameters of the concentration calculation, select "Alcohol [%]" instead of a
calculation function (see also Section 9.2). The density and the alcohol concentration are
printed out as the result, e.g.:

Accuracy Reproducibility

DE40: Alcoh  42.1 % ± 0.1 % ± 0.1 %
DE50/51: Alcoh  42.09 % ± 0.01 % ± 0.01 %

Note : The alcohol values of measurements with, e.g. whisky, are relative values: They do
not specify the actual concentration as the density also depends on all other
dissolved substances of this beverage.

14.3 BRIX software

With the BRIX software the measured density of a sucrose/water solution can be converted
to the weight percent sucrose content (°BRIX). The stored tabulated values are based on
table 109 of NBS Circular 440 (NBS: National Bureau of Standards, since 1988: National
Institute of Standards and Technology). The measurement temperature for the automatic
conversion is 20 °C.

Under the parameters of the concentration calculation, select "BRIX [%]" instead of a
calculation function (see also Section 9.2). The density and the BRIX degrees are printed out
as  the result, e.g.:

Accuracy Reproducibility (within 0 - 40 %)
DE40: BRIX  10.23 % ± 0.03 %     ± 0.03 %
DE50/51: BRIX  10.234 % ± 0.003 %     ± 0.003 %

Note : The BRIX values with, e.g. milk are relative values: They do not specify the actual
sucrose concentration as the density also depends on all other dissolved
substances of this beverage.

14.4 Viscosity correction

When measuring samples with higher viscosities (over 10 mPs), the oscillation tube
technique shows a slightly higher value than the real density of the samples. This application
corrects the systematic viscosity error when measuring samples with higher viscosities. See
section 6.2. for more information.

Special application cards
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14.5 Coke (Cola drinks)

This Memory Card allows to measure BRIX and HFCS42 (also called SOLIDS) of all Cola
products, from beverages to the highly viscous syrup (concentrate). This card includes
viscosity correction, required for syrup measurement and specially tuned up for Cola
products. This viscosity correction is especially required for products over 40°BRIX (resp.
50°SOLIDS).

14.6 Coefficients for conversion to various concentration data

With all software you can convert the measured density directly to Baumé, Twadell, API or
milk degrees:

In the Calc.Para menu select <Result>, <Conc.>, <Parameter Set>, <Coefficient>. Then:

–  select the relative density d 
t

4  or d 
t

t
–  select the term for the x-axis under Data Replace ,
–  select A + Bx  as calculation function,
–  enter the coefficients A and B under Manu Set .

The “Conc” value is printed out as the result in each case.

Concentration Conversion
function

Heavy Baumé deg.1) ((1/d) – 1) * -144.3 15.0 d 
t

4 (1/d) – 1 0 -144.3

Light Baumé deg.1) ((1/d) – 1) * 144.3 + 10 15.0 d 
t

4 (1/d) – 1 10 144.3

Jap. Sake degrees ((1/d) – 1) * 1443 15.0 d 
t

4 (1/d) – 1 0 1443

API degrees ((1/d) – 1) * 141.5 + 10 15.56 2) d 
t

t (1/d) – 1 10 141.5

Twadell degrees (d – 1) * 200 - - d 
t

4 d – 1 0 200

Milk degrees (d – 1) * 1000 - - d 
t

4 d – 1 0 1000

1)  Note:  replace 144.3 by 145 for USA.
2)  15.56 °C corresponds to 60 °F.

Special application cards

Meas.
temperature
[°C]

Relative
density

Term of the
x-axis

Coefficients of the
function A + Bx
A             B

Parameter Entry
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15.  Automatic sampling pump ASU-DE (optional)

This optional automatic sampling unit replaces the air pump that comes with the basic
installation. With its membrane pump it allows to aspire samples of low to medium viscosity
(at the max. ca. 1000 mPa·s) directly into the measurement tube, to empty, rinse and dry it
after the measurement.

The sequence described in section 8.5, used to control this routine, allows to eliminate
operator specific influences on the measurement which usually occur when using a syringe.
This option allows you to get reproducible results, regardless of the operator using the
instrument.

This pump is also required together with the DCU-300B auto rinsing unit, the SOP40 and
SOP50 and the CHG-260B sample changer.

Instead of using the standard waste bottle of the ASU-DE you can also use the automatic
draining unit AD-510.

15.1  Safety measures

Measures for your safety
- Make sure to switch off the DE40, DE50 or DE51 and disconnect the power cable before

installing the automatic sampling pump ASU-DE!
- Make sure that the solvents used to rinse the measurement tube do not form dangerous

mixtures or reactions when combined with the sample solutions or other solvents, since all
solutions are dejected into the same waste bottle!

- Connect the exhaust tube to a system capable of disposing of poisonous or corrosive gases!

Measures for operational safety
- Empty the waste bottle (drain pot) before it is filled to the rim! Otherwise the waste solution

is sucked into the pump and ejected through the exhaust. This could even damage the pump.
- The material in contact with the liquid for sampling is made of glass, Teflon or carbon. Do

not use any sample that may corrode the material.
Samples of high viscosity cannot be aspirated. Maximum viscosity that can be pumped is
approximately 1000 mPa-s.

Automatic sampling pump
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15.2  Installation

- Switch off the DE40/DE50/DE51 and
disconnect the power cable.

- Place the unit backside down as shown to
attach two rails for the holder of the waste
bottle.
Fasten Rail 1 by two screws. Slide in the
board into rail 1 and 2, and then fasten
rail 2 by two screws.

- The board can be slid under the instrument if
it is not in use.

- Detach rear panel and plate. Undo the four
screws fastened to the rear panel and pull
the small plate out of the panel as shown
(sits very tight).

- Remove the three large screws (marked with
red) just right of the air pump unit. These
screws are used as transportation security to
hold the measuring cell, which is mounted on
shock absorbers, firmly against the chassis
during transportation. Make sure to keep
these screws for future need of re-shipping.

- Remove the air pump.
a) Undo three screws fastened to the

pump unit.
b) Disconnect the pump connector (1) and

dry air tube (2).
c) Move the pump unit first to the right (ca.

3 cm), then up and remove it.

Note: Disconnect the dry air tube carefully in
order to avoid damage.

2

1

Automatic sampling pump

rail 1

rail 2
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- Install the ASU-DE in the place of the air
pump.

a) Slide in the ASU-DE down and to the left,
adjusting its bottom fitting to the angle
hole of the main unit.

b) Fasten the ASU-DE by the three screws
which were used to hold the air pump.

c) Connect the pump connector (3 black,
2-poles) and solenoid connector (4 white,
3 poles) to the main unit.

d) Connect the dry tube (5) to the joint for
the desicator tower.

- Install rear panel (Follow reverse steps from above).
- Attach the supplied seal (Align to line ”A”).

- Connect the air tube (tygon, with Teflon
connector at one and PP connector at the
other) to the dry air out (without black
tightening clamp).

- Insert the sampling tube (one connector only)
into the measuring cell inlet (lower port),
connect the drain tube (two connectors) to
the measuring cell out (upper port) to the
pump-in connector (black clamp).

Note : Make sure the white Teflon tube
nozzles are firmly tightened clockwise.

Automatic sampling pump

5

3

4
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Automatic sampling pump

Warning :
If using samples and rinsing solutions which
could create poisonous or corrosive gases,
connect the exhaust tube to the exhaust
connector and lead the other end to a system
capable of disposing of these gases.

- Connecting the waste bottle:
Connect the black tube from the pump unit to
the higher connector of the bottle cap and
tighten the screw firmly. Push the transparent
tube from the pump unit into the ohter
connector of the bottle cap, so that it
protrudes ca. 30 mm below. Then tighten the
screw firmly.

Note: If the connectors are not screwed in tightly, the pump will not (or hardly) be able to
move the sample.

- Pull out the plate for the waste bottle on the left side of the instrument, place the white plastic
mug on it, and put the waste bottle in the mug.
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16. Error Messages and Malfunctions

16.1 Error Messages

Error message Cause Measure

Nozzle error The sampling nozzle did not Remove the obstacle.
move normaly (SC24, DCU-300 or Replace the nozzle if it is bent or
SOP50. borken.

Press [Stop] key to reset the
error.

Table error The rotation of the turnable was Remove the obstacle.
not normal (SC24). Press [Stop] key to reset the

error.

Temperature The set temperature can not be Switch off the instrument and call
control error reached within 2 hours after start. METTLER TOLEDO service.

Communication Cable not connected correctly. Check connection of the
error communication cable.

Wrong instrument selected in Check that the correct instrument
Function 3. is selected in "Function 3": SC24,

CHG, DCU.

Viscosity Correction No adjustment with viscosity correction. Perform adjustment with viscosity cor-
Error rection on.

Air bubbles or smudge in the cell. Check measuring cell.

16.2 Malfunction

Malfunction Cause Measure

Instrument can Cable not plugged in properly, Check power cable and mains.
not be switched fuse blown. Replace fuse if blown (T3.15A/250V).

No "Ready" Air inlet at rear of the instrument Remove obstacles that block the
message is blocked. air inlet.
reached. Cooling fan not operating. Call METTLER TOLEDO service

for help.

Stored data are The internal battery is discharged. Swich off the instrument and call
lost (e.g. time) METTLER TOLEDO service.

Printer not DIP switch of printer not set Check DIP switch setting of the
printing. correctly. printer.

Wrong communication setting for Check setings in "Setup 0".
printer.

Error messages and malfunctions
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Malfunction Cause Measure

Nothing displayed Contrast has been changed. Call METTLER TOLEDO service
for help.

No key entry Call METTLER TOLEDO service
possible for help.

Measurement Sample not homogeneous, air bubbles Check factors mentioned.
not reproducible in the measuring tube, measurement Check if temperature is stabilized.

temperature unstable. Measurement cell filled completely?
Is the bench vibrating? Place instrument on a non-vibra-

ting bench.
Cell contaminated with old sample. Clean measuring cell thoroughly.

Air bubbles in the Leaking connections? Check connections.
sample i.e. mea- Sample likely to produce bubbles Degass sample (ultrasonic bath or
surement never or mixture containing components heating) or measure at reduced
ends or measuring with low coiling point? temperature.
times vary greatly. High sample viscosity? Use a syringe or warm up the sample.

Long sampling Wrong setting of the flow control Adjust the sampling speed to your
time. valve. sample with the valve.

Sample viscosity too high. Use a syringe to inject the sample.

Measurement of Switch off the instrument and call the
distilled water free METTLER TOLEDO service.
of air bubbles
takes too long.

Adjustment of the Air or gas bubbles are generated by Boil the distilled water, or degass it in
instrument with air the heating-up of the water in the an ultrasonic bath (at least at the
and water at higher measuring cell. measuring temperature), and inject it
temperatures takes at this higher temperature to avoid
too long. formation of air or gas bubbles.

Error messages and malfunctions
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17. Maintenance

17.1 Changing internal battery

The battery is used for data storage and has a service life of around 5 years when it is kept
charged. We thus recommend switching the instrument on now and then to ensure the
battery remains operational during this time.

17.2 Power line voltage, power line, fuse

The DE40/50/51 will adapt automatically to the power line voltage in the range of 100 to
240V and 50/60 Hz.

Changing blown fuses:
- Switch off the instrument and disconnect all cables on the rear of the instrument.

- Put the instrument on the rear side.

- Remove the small plate at the instrument’s bottom plate by unscrewing the 2 screws.

- Change the blown fuse(s) and put the small plate in place again. Make sure to use the correct
fuse type for replacement: T3.15A / 250V.

17.3 Replacing the silicagel

- Replace the silicagel of the drying tube when it becomes pink. If this is not done the drying
of the measurement tube (and thus the adjustment with dry air) is no longer assured.

17.4 Replacing the tube nozzles

If you find air bubbles in the measurement tube on every sample injection which do not
originate from the sample itself, the tube nozzle may be leaking or damaged. To change the
tube nozzles, proceed as follows:
- Carefully remove the protective silicone cap that holds the nozzles correctly in place. Make

sure not to tear at the rim, but hold its strong middle part with your fingers.

- Unscrew the tube nozzle anticlockwise and then screw in the new one tightly by hand. Do
not apply pressure as this would damage the measurement tube.

- Then put the protective silicone cap in place again with the squared hole at the bottom so
that leaking liquid from the cell unit can flow out.

Maintenance
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18. Standard and optional equipment

18.1 Standard equipment

Order No.

Operating instructions Englisch 51709838

Sampling/Drain tubes, 2 pcs (without joint) 51328032

Joint for Sampling/Drain tube (PTFE/PP) 51328035

Teflon tube nozzle (for connection to measuring cell) 51328027

Tube nozzle special (to use with joint with thread) 51322238

Joint with thread for Sampling/Drain tube (to be used 51322239
with tube nozzle special)

Exhaust tube (1m) 51328133

Desiccator 51322012

Silica gel 1kg 105080

Protective rubber for sample inlet 51322045

Standard and optional equipment
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Standard and optional equipment

18.2 Optional equipment

Fuse T3.15A 51522100

Plastic syringe 10mL (set of 100) 71482

Certified density standards:
8 mL vials, with certificate
- Water (0.99… g/cm3 +/- 0.00001) 51338002
- Beverage sirup (1.04… g/cm3 +/- 0.00010) 51338003
- Dichlorotoluene(1.26… g/cm3 +/- 0.00002) 51338004
- Fluorocarbon (1.95… g/cm3 +/- 0.00002) 51338005

Memory Cards:
- Data, methods and sample file storage 51324004
- Alcohol 51324000
- BRIX 51324001
- API 51324002
- Coke BRIX & solids 51324009
- Viscosity correction (for DE40) 51324003

GA42 printer:
- Alphanumerical printer (serial) GA42
- Set of paper rolls (5 pcs) 00072456
- Ribbon catridge (black) 00065975
- Connection cable (not included) 51190362

PC software  (for Windows 95 & 98):
- Data transfer software to EXCEL (version 7.0 or later) 51324100
- Data transfer software for DE/RE combination 51324101
- Connection cable to computer 51190362

ASU-DE sampling pump
- Sampling pump 51321500
- Waste bottle (250 mL) with lid 51322011

In use cover 51107119
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AD-510 Auto Drain Unit 51321807
(requires ASU-DE)

DCU-300B Auto Rinsing Unit 51321805
(requires ASU-DE)

CHG-260B Sample Changer (60 samples) 51321208

SOP40 Sample Operation Programmer, 4 steps 51321600

SOP50 Sample Operation Programmer, 5 steps 51321601

SC24 Sample Changers
- SC24 (basic version) 51321300
- SC24H (high temperature version, electrical heating) 51321301
- SC24L (low temperature version, requires water bath) 51321302

SC24 connection sets
- Connection to DE40/50/51 51322007
- Connection to DE/RE combination 51322009

Refractometers
The following refractometers can be connected to the
DE40/50/51 density meters for simultaneous measurement
of density and refractive index)
- RE40, 4 decimal places 51320400
- RE50, 5 decimal places 51320401

Refractometer connection sets
- DE/RE connection set (basic version) 51322010
- SC24 connection set to DE/RE combination 51322009

Standard and optional equipment
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MemoCard DE40/50/51 (Short Instructions)

Sample No, Sample ID
(and number of samples if
Sample file ON)
Viscosity correction (DE51, DE40 with
Memory Card Viscosity)

Select print format
off
short
GLP
variable

Set measurement parameter
Method name
Measuring temperature
Stability
Wait time
Sequence (ON/OFF)

Sampling
Drain
Rinse-1
Rinse-2
Purge

Calculation parameter
Result

d, d t
t , d

t
4

BRIX, API, Alcohol (if selected)
Concentration

(enter table)
(enter coefficients)

Temperature compensation
(enter coefficients)

Decimals
for dt

for dt
t , d

t
4  (if temp.comp. select.)

BRIX, API, Alcohol (if selected)
for Conc. (if Conc. selected)

Method selection
Method 0 to 9

Display selection
Density
Oscillation
BRIX, API, Alcohol (if so selected)
Conc. (if Conc. selected)

Print message or parameter

Start measurement
(including sample sequence
 if Sequence ON)

Report

Sample

Meas.
Para

Function

Setup

Print

Function selection
0. Data file
1. Sample file (ON/OFF)
2. Method File
3. Changer
4. Factor
5. Set check

(name, value, tolerance)
6. Periodic (check and adjustment)

(check interval)
(show check list)

7. Autostart
8. Card utility
9. Memory clear

Setup selection
0. Interface

(Printer, RS-232)
1. Date & Time
2. Name
3. Serial/Version No.
4. LCD contrast
5. International

(date format)
(°C or °F)

6. Lock
7. Beep
8. Temperature calibration

Run instrument check
Periodic check (on check date)
Daily check (all other dates)

Perform adjustment

Backspace (erase)

Rinse/Purge , only for SC24 and DCU-300
(Sequence must be ON)

Pump ON/OFF, for ASU-DE

Clear entry  (2 x to clear name)

Escape

Return to main displayReset

Esc.

Clear

Rinse/
Purge

BS

Calib.

Check

Pump

Display

Method

Measure

Calc.
Para



METTLER TOLEDO  DE40/50/51 Density Meter 89

Annex 1: Density table of dried air

The density of dried air at a specified temperature t and a atmospheric pressure of
760 mm Hg is calculated according to the following formula:

d (g/cm3) = 0.0012932 x p (mm  Hg)
1 + 0.00367 x t (°C) 760

The values stored in the instrument are listed in the table below. Intermediate values are
interpolated according to the LaGrange polynomial.

Temp. Density Temp. Density Temp. Density Temp. Density
[ °C] [ g/cm3] [ °C] [ g/cm3] [ °C] [ g/cm3] [ °C] [ g/cm3]

0 0.00129 25 0.00118 50 0.00109 75 0.00101
1 0.00129 26 0.00118 51 0.00109 76 0.00101
2 0.00128 27 0.00118 52 0.00109 77 0.00101
3 0.00128 28 0.00117 53 0.00108 78 0.00101
4 0.00127 29 0.00117 54 0.00108 79 0.00100
5 0.00127 30 0.00116 55 0.00108 80 0.00100
6 0.00127 31 0.00116 56 0.00107 81 0.00100
7 0.00126 32 0.00116 57 0.00107 82 0.00099
8 0.00126 33 0.00115 58 0.00107 83 0.00099
9 0.00125 34 0.00115 59 0.00106 84 0.00099

10 0.00125 35 0.00115 60 0.00106 85 0.00099
11 0.00124 36 0.00114 61 0.00106 86 0.00098
12 0.00124 37 0.00114 62 0.00105 87 0.00098
13 0.00123 38 0.00113 63 0.00105 88 0.00098
14 0.00123 39 0.00113 64 0.00105 89 0.00097
15 0.00123 40 0.00113 65 0.00104 90 0.00097
16 0.00122 41 0.00112 66 0.00104
17 0.00122 42 0.00112 67 0.00104
18 0.00121 43 0.00112 68 0.00103
19 0.00121 44 0.00111 69 0.00103
20 0.00120 45 0.00111 70 0.00103
21 0.00120 46 0.00111 71 0.00103
22 0.00120 47 0.00110 72 0.00102
23 0.00119 48 0.00110 73 0.00102
24 0.00119 49 0.00110 74 0.00102

Chemical Handbook Fundamental Version, Rev. 3, Table 5.1 (1984).

Density tables
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Annex 2: Density table of pure water

The instrument has stored the density of water at 760 mm Hg according to the following
table:

Temp. Density Temp. Density Temp. Density
[ °C] [ g/cm3] [ °C] [ g/cm3] [ °C] [ g/cm3]

0 0.99984 25 0.99705 50 0.98805
1 0.99990 26 0.99679 55 0.98570
2 0.99994 27 0.99652 60 0.98321
3 0.99996 28 0.99624 65 0.98057
4 0.99997 29 0.99595 70 0.97779
5 0.99996 30 0.99565 75 0.97486
6 0.99994 31 0.99534 80 0.97183
7 0.99990 32 0.99503 85 0.96862
8 0.99985 33 0.99471 90 0.96532
9 0.99978 34 0.99438

10 0.99970 35 0.99404
11 0.99961 36 0.99369
12 0.99950 37 0.99333
13 0.99938 38 0.99297
14 0.99925 39 0.99260
15 0.99910 40 0.99222
16 0.99894 41 0.99183
17 0.99878 42 0.99144
18 0.99860 43 0.99104
19 0.99841 44 0.99033
20 0.99821 45 0.99022
21 0.99799 46 0.98980
22 0.99777 47 0.98937
23 0.99754 48 0.98894
24 0.99730 49 0.98849

Chemical Handbook Fundamental Version, Rev. 3, Table 5.2 (1984).

Density tables
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Specifications

Specifications

Type and model name Digital density meter DE40, DE50, DE51

Measuring method Oscillating U-tube

Density DE40 DE50, DE51

Measuring range d 0.0001 to 3 g/cm3 0.00001 to 3 g/cm3

Limit of error d 1 x 10-4 2 x 10-5

Repeatability d 1 x 10-4 1 x 10-5

Resolution d 1 x 10-4 1 x 10-5

Temperature

Control Peltier

Range T 4 – 90 °C 4 – 70 °C

Precision T 0.05 °C (10 to 30 °C) 0.02 °C (10 to 30°)
T 0.1 °C ( 4 to 90 °C) 0.05 (4 to 70 °C)

Viscosity compensation Memory Card (option) DE50: not possible
DE51: standard

Sample required min. 1.2 mL (manual injection with syringe)
min. 2 mL (automated operation with optional pump)

Typical meas. times 1 to 4 minutes (manual operation)
2 to 10 minutes (programmed automated operation)

Display LCD (Liquid crystal display): 7 line display, backlit

External I/O 1 RS-232C (for computer and combination)
1 RS-232C (for external printer)
1 special serial interface (for sample changer)
1 Memory Card (PCIMCIA)

Ambient condition 1) Temperature: 5 ~ 35 °C
2) Humidity: below 85 % RH (no condensation)

Power source AC 100-240 V, 50/60 Hz

Power consumption 200 W

Dimension 270 mm (W) x 400 mm (D) x 410 mm (H)

Weight 15 kg
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FCC Rules and Radio Interference Regulations

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to both Part 15 of the FCC Rules and the radio interference regulations of
the Canadian Department of Communications. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential
area is like to cause harmful interference in which case the user will be required to correct the
interference at his own expense.

FCC Rules and Radio Inteference Regulations





To protect your METTLER TOLEDO product’s future:
METTLER TOLEDO Service assures the quality, measuring accuracy and
preservation of value of all METTLER TOLEDO products for years to come.
Please send for full details about our attractive terms of service.
Thank you.
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Printed on 100% chlorine-free paper, for the sake of our environment.

Mettler-Toledo GmbH, Analytical, Sonnenbergstrasse 74, CH-8603 Schwerzenbach, Tel. (01) 806 77 11, Fax (01) 806 73 50,
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Subject to technical changes and to the availability
of the accessories supplied with the instruments.
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